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File menu commands

File Bar:

The File menu provides the following commands:

New Creates a new project.
Open Opens an existing project.
Introductory Project Opens the IMS Introductory Tutorial.
Open Template Opens an existing template project.
Save Saves an opened project using the same file name.
Save As Saves an opened project to a specified file name.
Restore Last Restores the project to its last Save state.
Recover Previous Recovers the project to the Previous Save state.
Export HTML Export the current project in HTML format
Export_Bitmap Export the current page or selected object as a bitmap

file.
Import HTML Shortcut to the Text Dialog Load command.
Import_Bitmap Shortcut to the Sprite Open File dialog.
Print Prints a document.
Print Preview Displays the document on the screen as it would 

appear printed.
Print Setup Selects a printer and printer connection.
Exit Exits IMS Studio.



Help menu commands

File Bar:

The Help menu provides the following commands, which provide you assistance with this 
application: 

Help Topics Offers you an index to topics on which you can get 
help.

Tutorials Displays a HTML tutorial page.
About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in IMS Studio.

You can open an existing document with the Open command.

Shortcuts

File Bar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing project “.ims” file in a new window. You may only 
have one project open at a time. If a project is currently open, you will be prompted to save 
it first. This command will display the standard file open dialog. 

You can create a new project with the New command.

Shortcuts

File Bar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the selected 
extension. 

List Files of Type
Select the type of file you want to open. The most appropriate extensions will be listed.

Drives
Select the drive from which IMS Studio will display the potential directories to list. 

Directories
Select the directory in which IMS Studio lists the potential files to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    IMS Studio 
suggests that you save changes to your document before you close it.    If you close a 
document without saving, you lose all changes made since the last time you saved it.    
Before closing an untitled document, IMS Studio displays the Save As dialog 
boxAFX_HID_FILESAVE and suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:

Shortcuts

File Bar:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, IMS Studio displays the Save As dialog 
boxAFX_HID_FILESAVE so you can name your document.    If you want to change the name 
and directory of an existing document before you save it, choose the Save As command.

Shortcuts

File Bar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    IMS Studio displays the Save As
dialog boxAFX_HID_FILESAVE so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog boxes
This dialog allows you to select a file name, extension type and path for saving a file to disk.

File Path Option Dialog
The following options allow you to specify the name and location of the file you're about to 
save:

File Name
Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    IMS Studio adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Restore Last (File menu)

This command will Restore a project to its last save state. All work between the current state
of the project and the last save will be lost.



Recover Previous (File menu)

This command will Recover a project from its Backup file. A Backup file is made each time an
IMS project is loaded or saved. Recovering a project is consequently equivalent to loading 
the previous Save or the initial project if no saves are made. The Backup file is also used for 
crash recovery if the program is terminated abnormally.



Export HTML command (File menu)

Use this command to publish the current project as a set of HTML and Javascript files.    IMS 
Studio displays the Export HTML Dialog so that you can name your HTML documents and 
specify file path options.

See the section How to Export HTML for more details.

Shortcuts
File Bar:

Keys: CTRL+H



Export Bitmap command (File menu)

IMS Web Engine

Use this command to export the selected pages or objects as a bitmap image.    IMS Web 
Engine displays the Export Bitmap dialog so that you can select a Page or Object to export. 
Upon confirming your selection with the OK button IMS Web Engine will display the Save As 
dialog boxAFX_HID_FILESAVE Use The Save As dialog to select an image format and file 
name. The default name will be the name used as the Object or Page name with the 
selected format type appended. Exporting “Page1” as a GIF file would create “Page1.gif” in 
the specified directory.

Shortcuts
File Bar:



Import HTML command (File menu)

This is a shortcut command to the Text Editor load option. The Text_Editor is used to create, 
load and edit text in several different formats.



Import Bitmap command (File menu)

This is a shortcut command to the Object Sprite dialog. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your IMS Studio session.    You can also use the Close command on 
the application Control menu.    IMS Studio prompts you to save documents with unsaved 
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Status Bar

The status bar is displayed at the bottom of the IMS Studio window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The Status bar is separated into five sections:

Menu Actions
The left area of the status bar describes actions of menu items as you use the arrow keys
to navigate through menus.    This area similarly shows messages that describe the 
actions of toolbar buttons as you depress them, before releasing them.    If after viewing 
the description of the toolbar button command you wish not to execute the command, 
then release the mouse button while the pointer is off the toolbar button.

Object Actions
This area describes the operation that is being performed on the currently selected 
object.

Object Selection
This area displays the name of the currently selected object.

Page Selection
This area displays the name of the currently selected page.

Key Actions
The right areas of the status bar indicate which of the following keys are latched down: 

CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using IMS Studio and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of IMS 
Studio.

Shortcuts
File Bar:



Context Help command 

Use the Context Help command to obtain help on some portion of IMS Studio.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the IMS Studio window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcuts
File Bar:

Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave 
in your application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the IMS Studio window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    IMS Studio determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    IMS Studio determines
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>



Update command (File menu)

<< Write a topic here that discusses the Update command. >>



Save Copy As... command (File menu)

<< Write a topic here that discusses the Save Copy As... command. >>



Embedded Object Resize Bar

<< Write a topic here that discusses the embedded object resize bar. >>



                                                



Page menu commands

Page Bar:

The Page menu provides the following commands:

Editor Display the Page Editor Dialog.
Page Select Lists all pages and the current page. 
Object List List all objects in the current page.
Append Page Appends a new page to the end of the project.
Insert Page Inserts a new page in front of the current page.
Cut Page Cuts the current page from the project.
Copy Page Copies the current page.
Paste Page Paste the current page.
Zoom Page Zoom the current page.
Normal View Restore the current page normal view.
Background Display the Page Background Dialog.
Music Display the Page Music Dialog.

See Understanding Pages for more details on using IMS Web Engine Pages.



Page Editor command (Page menu)

Displays the IMS Web Engine Page_Editor dialog. The Page Editor provides functions for 
entering Meta Tags, timed Links and a Title for your HTML page.

See Understanding Pages for more details on using IMS Web Engine Pages.

Shortcuts
Page Bar:



Page Select Edit box (Page menu)

Lists all pages in the project. Move to a different page by selecting it from the drop down 
box. 



Object List box (Page menu)

Lists all objects included in the current page. Select a new current object from the drop down
list.



Append Page command (Page menu)

Append a new Blank Page to the end of the project.

Shortcuts
Page Bar:



Insert Page command (Page menu)

Insert a new Blank Page in front of the current page.

Shortcuts
Page Bar:



Cut Page command (Page menu)

Delete the current page and leave a copy on the clipboard.

Shortcuts
Page Bar:



Copy Page command (Page menu)

Copy the current Page to the clipboard.

Shortcuts
Page Bar:



Paste Page command (Page menu)

Insert a copy of the Page from the clipboard. A copied page includes the same Objects as the
source page. Moving an Object on a pasted page will also move it on the parent page.

Shortcuts
Page Bar:



Zoom command (Page menu)

Puts IMS Web Engine into Zoom Mode. When in Zoom Mode, the program will zoom in on the
current cursor position by approximately 20% each time the left mouse button is pressed. 
Pressing the right mouse button or Shift L-Button will zoom out by an equivalent amount.

Pressing the Normal View button  will return the work window to its normal state.

Shortcuts
Page Bar:



Normal View command (Page menu)

Restores the IMS Web Engine work window to its normal zoom and scroll position. This 
command will also return the program to Select mode for normal Object editing.

Press the Zoom Page button  to enter Zoom Mode.

Shortcuts
Page Bar:



Page Background command (Page menu)

Will display the Page_Background dialog. A Page can have a solid color, bitmap or pattern 
background. See Understanding Pages for more details.

Shortcuts
Page Bar:



Page Music command (Page menu)

Will display the Page_Music Dialog.

Shortcuts
Page Bar:



Options menu commands

The Options menu provides the following commands for setting various work space options:

Set Tools Options Displays the Tools Options dialog.
Set HTML Options Displays the HTML Options dialog.
Guide Border Display or Hide the target resolution guide border.
Grid Guide Display or Hide grid guide lines.
Snap Grid Enable or Disable the Snap Grid.



Set Tools command (Options menu)

Use this command to display the Tool Options dialog. This dialog can be used to select Tool 
Bar and Work Window options.



Set HTML command (Options menu)

Use this command to display the Set HTML Options dialog. This dialog can be used to select 
HTML Page options and guides.



Set Word Processor (Options menu)

Use this command to display the Set Word Processor dialog. This dialog can be used to 
select the default Word Processor file type.



Guide Border command (Options menu)

This button will toggle the Guide Border On and Off. The guide border resolution can be set 
with the Tool Options dialog.

See the section on Working in the IMS Window for information on using the Guide Border and
other aides.

Shortcuts Keys: CTRL+B



Guide Grid command (Options menu)

This button will toggle the Guide Grid On and Off. The guide border resolution can be set 
with the Tool Options dialog.

See the section on Working in the IMS Window for information on using the Guide Grid and 
other aides.

Shortcuts Keys: CTRL+G



Snap Grid command (Options menu)

This button will toggle the Snap Grid On and Off. The snap grid resolution can be set with the
Tool Options dialog.

See the section on Working in the IMS Window for information on using the Snap Grid and 
other aides.

Shortcuts Keys: CTRL+M



Arrange menu commands

Arrange Bar:

The Arrange menu provides the following commands:

Align Left Align the selected Group Objects to the left.
Align Vertical Align the selected Group Objects vertically.
Align Right Align the selected Group Objects to the right.
Align Top Align the selected Group Objects to the top.
Align Horizontal Align the selected Group Objects horizontally.
Align Bottom Align the selected Group Objects to the bottom.
Space Horizontal Evenly space the selected Group Objects Horizontally.
Space Vertical Evenly space the selected Group Objects Vertically.
To Front Moves the selected Object in front of all other Objects.
To Back Moves the selected Object behind all other Objects.
Forward Moves the selected Object forward one position.
Back Moves the selected Object back one position.
Group Converts a temporary Group Object into a Group Object.
Ungroup Breaks a Group Object into its member Object.
Align Left command (Arrange menu)

Aligns the left edge of all Objects in a temporary group with the left edge of the group.

Shortcuts
Arrange Bar:



Align Vertical command (Arrange menu)

Aligns the center of all Objects in a temporary group along the vertical center of the group.

Shortcuts
Arrange Bar:



Align Right command (Arrange menu)
 
Aligns the right edge of all Objects in a temporary group with the right edge of the group.

Shortcuts
Arrange Bar:



Align Top command (Arrange menu)

Aligns the top edge of all Objects in a temporary group with the top edge of the group.

Shortcuts
Arrange Bar:



Align Horizontal command (Arrange menu)

Aligns the center of all Objects in a temporary group with the horizontal center of the group.

Shortcuts
Arrange Bar:



Align Bottom command (Arrange menu)

Aligns the bottom edge of all Objects in a temporary group with the bottom edge of the 
group.

Shortcuts
Arrange Bar:



Space Horizontal command (Arrange menu)

Evenly spaces all Objects in a temporary group horizontally between the left and right edges
of the group.

Shortcuts
Arrange Bar:



Space Vertical command (Arrange menu)

Evenly spaces all Objects in a temporary group vertically between the top and bottom edges
of the group.

Shortcuts
Arrange Bar:



To Front command (Arrange menu)

Moves the selected Object in front of all other Objects. Intersecting Objects will be obscured 
by this Object.

Shortcuts
Arrange Bar:



To Back command (Arrange menu)

Moves the selected Object behind all other Objects. Intersecting Objects will obscure this 
Object.

Shortcuts
Arrange Bar:



Forward command (Arrange menu)

Moves the selected Object forward one position on the Z axis. This Object will obscure 
Objects behind it and will be obscured by Objects in front..

Shortcuts
Arrange Bar:



Back command (Arrange menu)

Moves the selected Object back one position on the Z axis. This Object will obscure Objects 
behind it and will be obscured by Objects in front..

Shortcuts
Arrange Bar:



Group command (Arrange menu)
 
Creates a Group Object from a temporary group. 

To create a temporary group, hold the left mouse button down and drag a bounding box 
completely around all Objects to be grouped. Upon releasing the mouse button the Group 
button will be highlighted and can be pressed to convert the temporary group into a 
permanent group.

Align and Space operations may only be performed on a temporary group.

For more information on Group Objects see the section Understanding Groups.

Shortcuts
Arrange Bar:



Ungroup command (Arrange menu)
 
Breaks a Group Object into its component Objects. When a Group Object is selected, the 
Ungroup button will become highlighted and can be pressed. 

For more information on Group Objects see the section Understanding Groups.

Shortcuts
Arrange Bar:



Edit menu commands

The Edit menu provides the following commands:

Undo Reverse previous editing operation.
Redo Reverse previous Undo operation.
Cut Cuts an Object from the current page and moves it to the clipboard.
Copy Copies an Object from the project to the clipboard.
Delete Deletes an Object from all Pages in the project.
Paste Pastes an Object from the clipboard into the current page.
Clone Clones an Object from the clipboard into the current page.
Include Includes an Object from the clipboard into the current page.



UNDO command (Edit menu)

Use this command to UNDO the previous edit operations on the selected Object. There are 
two levels of UNDO. Level one will restore the Object to its state prior to the previous 
transform. Level two will restore the Object to its state when selected.

When no UNDO operation is possible, the UNDO button will be grayed.

Shortcuts
Keys: CTRL+Z



REDO command (Edit menu)

Use this command to REDO the transform operation that has just been undone with the 
UNDO command. 

When the REDO operation is not possible, the REDO button will be grayed.

Shortcuts
Keys: CTRL+Y



Cut command (Edit menu)

The CUT command will remove an Object from the current page and copy it to the clipboard.
An Object that has been Cut from the current page will not be remove from any other pages 
into which it has been included. You can    Paste, Clone or Include an Object that has been 
cut into any page in the project.

Shortcuts
Toolbar:

Keys: CTRL+X
 



Copy command (Edit menu)

The COPY command will copy the selected Object to the clipboard. You can    Paste, Clone or 
Include an Object that has been copied into any page in the project.

Shortcuts
Toolbar:

Keys: CTRL+C



Delete command (Edit menu)

The Delete command will remove an Object from all pages in the project. Any components 
such as Events or Actions that reference a deleted object will have the reference removed. 
Use the Cut command to remove an Object from the current page without deleting its 
definition. 

Shortcuts
Keys: Delete



Paste command (Edit menu)

The Paste command will create a duplicate of the Object and its components in the clip 
board and include the new Object in the current Page. Objects in the clipboard can also be 
Cloned or Included into the current page.

Refer to the section Understanding Objects for more information.

Shortcuts
Toolbar:

Keys: CTRL+V



Clone command (Edit menu)

The Clone command will create a duplicate of the Object in the clip board with the same 
components and include the new Object in the current Page. Changing a component of a 
cloned Object will change all objects that use the same component. Objects in the clipboard 
can also be Pasted or Included into the current page.

Refer to the section Understanding Objects for more information.

Shortcuts
Toolbar:



Include command (Edit menu)

The Include command will use the definition of the Object in the clip board in the current 
Page. An Included Object will have exactly the same transformation and components in 
every page in which it is included. Moving an Object on one page will move it to the same 
location in every page into which it is Included. Objects in the clipboard can also be Pasted 
or Cloned into the current page.

Refer to the section Understanding Pages for more information.



View menu commands

The View menu provides the following commands:

File Bar Shows or hides the file bar.
Status Bar Shows or hides the status bar.

Tool Bar Shows or hides the tool bar.
Page Bar Shows or hides the page bar.
Object Bar Shows or hides the object bar.
Arrange 
Bar

Shows or hides the arrange bar.

Preview 
Bar

Shows or hides the preview bar.



File Bar command (View menu)

Use this command to display or hide the File Bar. 

You can change the size of any toolbar with the Set Tools Options dialog in the tools menu.

See the topic About Toolbars for additional information on using the toolbars.



Status Bar command (View menu)

Use this command to display or hide the Status Bar. The Status Bar is located at the bottom 
of the IMS Web Engine window and describes:
1. The action to be executed by the selected menu item or depressed toolbar button.
2. The transformation being performed on the current Object.
3. The current selected Object.
4. The current Page. 
5. The keyboard latch state. 

A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for more information about the status bar.



Page Bar command (View menu)

Use this command to display or hide the Page Bar. 

You can change the size of any toolbar with the Set Tools Options dialog in the tools menu.

See the topic About Toolbars for additional information on using the toolbars.



Object Bar command (View menu)

Use this command to display or hide the Object Bar. 

You can change the size of any toolbar with the Set Tools Options dialog in the tools menu.

See the topic About Toolbars for additional information on using the toolbars.



Arrange Bar command (View menu)

Use this command to display or hide the Arrange Bar.
 
You can change the size of any toolbar with the Set Tools Options dialog in the tools menu.

See the topic About Toolbars for additional information on using the toolbars.



Preview Bar command (View menu)

Use this command to display or hide the Preview Bar. 

You can change the size of any toolbar with the Set Tools Options dialog in the tools menu.

See the topic About Toolbars for additional information on using the toolbars.



Tools Bar command (View menu)

Use this command to display or hide the Tools Bar. 

You can change the size of any toolbar with the Set Tools Options dialog in the tools menu.

See the topic About Toolbars for additional information on using the toolbars.



About Toolbars

The IMS user interface provides 6 floating Tool Bars docked by default to the Top, Left and 
Right margins. Each toolbar includes a handle that can be used to drag the tool bar to any 
location in the IMS Web Engine work window. As the tool bar approaches the edge of the 
window it will automatically dock. You can use the Set Tools Options dialog located under the
Tools menu to select Large Toolbars when working at high resolution or to turn the bars on 
and off. IMS Web Engine will save and attempt to restore the toolbars to their last location 
when you exit and restart the program.

The File Bar is initially located along the top edge of the window. Use these buttons for 
loading and saving your projects in addition to exporting HTML and image bitmap files. 

The Page Bar is initially located to the right of the File Bar. These buttons are used to add, 
delete and move the pages in your project. In addition you can select background colors, 
bitmaps and music.

The Object Bar is initially located below the File Bar. It displays the selected Object and its 
current components. 

The Preview Bar provides shortcut buttons to the is located to the left of the Object Bar. 
These four buttons provide the ability to preview either the current page or your entire 
project as they would appear in either a v3.2 or v4.0 Browser.

The Tools Bar is initially located along the left edge of the window. The Tools Bar is used to 
create and edit the components of an Object. These include geometry, bitmaps, text, 
shading, action(mechanics) and behaviors.

The Arrange Bar is initially located along the right edge of the screen. The Arrange Bar is 
used to group objects and to help position an object on the page.
    



Geometry Dialog Sheet

The Geometry Editor provides the following dialog pages:

List Select the current geometry.
Outline Sets outline width and color.
Origin Sets the geometry origin.



Options Dialog (Geometry Editor)

Name: 
Displays the name of the current Geometry being edited. Use the drop down box to edit 
another Geometry component. 

You can change the name of the current geometry by typing a new name into the edit 
box. Geometry names must contain ten or fewer characters, must not start with an 
alphanumeric character and must not contain any special characters. By default, names 
will be assigned as: Geo1, Geo2. Geo3 etc. Change these name to be more descriptive in
the current project but keep it simple.

Type: 
Displays the geometry type. This can not be changed. Valid types include, Rectangle, 
Ellipse, Shape, Sprite and Text.

File Path: 
Displays the file path to a Sprite Geometry. If the current geometry is not a sprite, this 
edit control will be dimmed. If the current geometry is a sprite, this edit control will 
display the directory path to the sprite. You can change the sprite by pressing the down 
arrow and selecting a new directory path to another sprite bitmap. This function is 
particularly useful    when you wish to move a sprite from one drive directory to another.

Copy: 
Duplicates the current geometry to create an identical new geometry.

Delete: 
Deletes the current geometry.

Clean: 
This operation checks for orphaned Geometry and offers to Delete any Geometry that is 
not used by any Objects or other components.



Outline Dialog (Geometry Editor)

Line color: 
Provides sliders to adjust the RGB color of the geometry outline. The Select Button will 
display a standard MS color dialog to provide an alternative method to select the outline 
color.

Line Width: 
Specifies the width of the outline in pixels. Adjust the slider or enter an integer value into
the edit box. The No Line button provides an alternative way to select a zero line width.



Origin Dialog (Geometry Editor)

Defines the origin of the geometry. All geometry is created in its own coordinate system. The
geometry origin by default is consequently at 0,0 on the x, y axes. Scaling, stretching, 
rotation and the origin of the object along a motion path is consequently based upon the 
geometry’s coordinate origin. The Origin dialog provides a means of shifting the Geometry 
origin from the center of the Geometry. Nine buttons are available to set the origin at the 
corners of the geometry, at the center of each edge or the center of the Geometry. The two 
edit boxes will display the coordinate value of the origin and can be used to enter any 
integer value to specify a specific coordinate.



Action Dialog Sheet

This dialog is available in IMS Web Engine

The Action Editor provides the following dialog pages:

Selection Selects the Action to edit.
Path Selects an animation path.
Rate/Counter Sets the Action speed, path length and path counter.
Orientation Change geometry by its orientation.



Selection Dialog (Action Editor)

Current: 
Displays the name of the current Action being edited. Use the drop down box to edit 
another Action component. 

You can change the name of the current Action by typing a new name into the edit box. 
Action names must contain ten or fewer characters, must not start with an alphanumeric 
character and must not contain any special or blank characters. By default, names will 
be assigned as: Act1, Act2. Act3 etc. Change these names as desired to be more 
descriptive of the Action.

Create: 
Duplicates the current Action to create an identical new Action.

Delete: 
Deletes the current Action. IMS Web Engine will test all Objects and Behaviors and 
remove any references to this Action

Assigned Objects: 
A list of all Objects that include this Action component.



Path Dialog (Action Editor)

Select an Objects’ animation path. Three types of paths are available. Linear Paths are 
straight line paths in one of eight directions. Object paths use the Geometry of another 
Object and can be used to create hierarchical motion. Interactive paths use the mouse to 
move an Object.

Inverse Mechanics is the hierarchical combination of paths that use multiple Objects.

Linear Paths
Selects one of eight directions to move an Object. The direction is identified by the arrow
on each button. The Stop button will disable motion. The Start, Center and End check 
boxes identify the start and end position of the path.
Start: When selected, the Object will start its motion from its current position.
Center: When selected, the Object will pass through its current position half way along

the path.
End: When selected, the Object will end at its current position.

The linear path length is double the target width of the HTML page as set in the Set 
HTML Options dialog.

Object Path
Selects an Objects’ Geometry to provide a motion path. When an Object is selected from 
the drop down box, it will be displayed to help identify it. 
Trace Path: When this button is selected, the current Object will trace the 
Geometry of the Object Path.
Trace Origin: When this button is selected, the current Object will trace the Origin of 

the Object Path.

Hierarchical Motion is created when the Object Path also has an Action assigned to it.

Unpredictable results may occur if Objects recursively trace each other or themselves. 

Interactive Path
Selects the mouse on either the X and Y axes to guide the Object. When both axes are 
selected, the object will be fixed to the movement of the mouse. When only one axis is 
selected, the object will move with the mouse on that axis and stay fixed to its current 
location on the other.



Rate and Counter Dialog (Action Editor)

Selects the speed and direction of an Object and the number of times to trace a path. 

Rate Slider 
Use the Rate slider to set the Objects speed. Use positive values to go forward and 
negative values to go back. The higher the value the faster the speed. The rate has no 
effect on Interactive Paths.

Path Counter 
Sets the number of times the Object will trace the path before the End Path condition is 
met and the Object stops. Use the slider to set a path count up to 100. Larger values can
be typed directly into the Edit Value box. The “Continuous” check box will set a value of -
1 which will set continuous play.

Path Length
Sets the length of a linear path. The default 100% = 1.5 * the screen height. Use the 
slider to reduce the path length.

By default when selected, Interactive Motion and closed shapes will set continuous play. 
Linear paths and open shapes will set single play.



Orientation Dialog (Action Editor)

Provides the ability to dynamically change an Objects’ Geometry as its direction changes.

When a “Change When” check box is enabled, the program will change the Geometry of the 
Object to the Geometry specified in the associated drop down box when the Object changes 
to the enabled direction. The display window can be used to help identify an Objects’ 
Geometry.

If an Object is created specifically to provide Geometry for this function, the Object can be 
made Invisible with the Options dialog of the Object Editor. 



Behavior Dialog Sheet

This dialog is available in IMS Web Engine

The Behavior Editor provides the following dialog pages:

Selection Select the current Behavior.
Trigger_Event Define activate triggers.
End_Event Define deactivate triggers.
Links Define on activation links.
Actions Define on active/deactivate Actions.
Formulas Define on active formulas.
Metamorph Define on active metamorphs



Selection Dialog (Behavior Editor)

Name: 
Displays the name of the current Behavior being edited. Use the drop down box to edit 
another Behavior component. 

You can change the name of the current Behavior by typing a new name into the edit 
box. Behavior names must contain ten or fewer characters, must not start with an 
alphanumeric character and must not contain any special characters. By default, names 
will be assigned as: Evt1, Evt2. Evt3 etc. Change these names as necessary to be more 
descriptive in the current project.

Copy: 
Duplicates the current Behavior to create an identical new Behavior.

Delete: 
Deletes the current Behavior. All Objects and Behavior references to this Behavior will be 
tested and replaced with a null reference as necessary.

Assigned Objects: 
Will list all Objects that contain this Behavior component.



Trigger Event Dialog (Behavior Editor)

Trigger Events cause the Object to enter Active mode. When an Object becomes active, it 
will perform the When Active operations until an End_Event is triggered. User Triggers 
depend upon an action by the user. Dynamic Triggers are initiated by a condition such as a 
counter or Object intersection. An Object can also be triggered Active externally by another 
Object.

Mouse Select
An Event caused by selecting the Object with the mouse. 

Mouse Over
An Event caused by moving the cursor over the Object.

Keyboard Select
An Event caused by pressing a keyboard character. Enter the character into the edit box. 

At Specified Time
An event triggered after the specified number of seconds (approximate). The counter 
starts as soon as the Object becomes deactive.

On Object Enter
An Event caused when an Object intersects with the Object containing this component. 
Select the intersecting Object from the combo box. 

On Object Leave
An Event caused when an Object does not intersect with the Object containing this 
component. 

At Object Value
An Event caused when the formula becomes true. Select any combination of equals “=”, 
less than “<”, or greater than “>” and the value to be compared to the Objects value. 
See the Formulas dialog for more details.

At Path End
An Event caused when the Object has completed tracing a path. The number of times an 
Object traces a path is specified by the Path Counter of an Action Component. 

And All Triggers
When this box is selected, all combinations of selected triggers must be true to trigger 
the Event. When this box is not selected, any selected trigger becoming true will trigger 
the Event.



End Event Dialog (Behavior Editor)

End Events cause the Object to enter Not Active or Deactive mode. When an Object 
becomes deactive, it will perform the When Not Active operations until a new Trigger_Event 
is activated. User Resets depend upon an action by the user. Dynamic Resets are initiated by
a condition such as a counter or Object intersection. An Object can also be triggered 
Deactive externally by another Object.

Mouse Up
The Event ends when the mouse button is released. 

Mouse Leave
The Event ends when the mouse leaves the Object box.

Keyboard Select
The Event ends when the specified keyboard character is pressed. Enter the character 
into the edit box. 

At Specified Time
The Event ends after the specified number of seconds (approximate). The counter starts 
as soon as the Object becomes Active.

On Object Enter
The Event ends when an Object intersects with the Object containing this component. 
Select the intersecting Object from the combo box. 

On Object Leave
The Event ends when an Object does not intersect with the Object containing this 
component. Select the non-intersecting Object from the combo box. 

At Object Value
The Event ends when the formula becomes true. Select any combination of equals “=”, 
less than “<”, or greater than “>” and the value to be compared to the Objects value. 
See the Formulas dialog for more details.

At Path End
The Event ends when the Object has completed tracing a path. The number of times an 
Object traces a path is specified by the Path Counter of an Action Component. 

And All Resets
When this box is selected, all combinations of selected triggers must be true to end the 
Event. When this box is not selected, any selected trigger becoming true will end the 
Event.



Links Dialog (Behavior Editor)

Links are initiated when the Behavior activates the Object. An Anchor link can also be 
assigned to an Object outside of a Behavior. See the Object Anchor dialog for more details.

URL Link
Links to the specified URL. Enter the correct URL path into the edit box.

Page Link
Links to another page in the current project. IMS Web Engine will enter the correct path 
to the referenced page.

No Link
Disables a link.



Actions Dialog (Behavior Editor)

Actions are initiated when an Object becomes Active or Deactive. Active actions are initiated
by Trigger_Events. Deactive Actions are triggered by End_Events. The Options under  ‘When 
Triggered Active’ and ‘When Not Active’ are identical in their operation and only differ in 
when they are applied. To make an Object ‘appear’ and ‘disappear’ as the mouse moves 
over it, you would consequently set the appropriate Trigger_Events and  End_Events. and 
enable the Visible button under ‘When Triggered Active’ and disable it under ‘When Not 
Active’.

Motion
Enables the Object to have motion. When disabled, this option will override the Object’s 
Action component to prevent the Object from moving.

Visible
When disabled, this option will make the Object Invisible.

Animate
This option is available for future updates.

Sound
This option is available for future updates.

Trigger Behavior
This option will trigger the specified Object Active. Select an Object to trigger from the 
combo box.

Reset Behavior
This option will reset the specified Object ‘Not Active’. Select an Object to reset from the 
combo box.

Reset Path
Will cause the Object to start at the beginning of its motion path and reset its path 
counter to zero.

Reset Triggers
Will reset the Object’s ‘Trigger Events’ so that the Object can be triggered Active again. If
the Object is in the Active state, this operation will bypass the ‘End Event' triggers and 
the ‘When Not Active’ actions. If this flag is not checked in the ‘When Not Active’ state, 
no more triggers will be possible unless the Object is Reset by an external Object.



Formulas Event Dialog (Behavior Editor)

Every Object has an Integer value associated with it. This value can be used as a 
Trigger_Event and End_Event to switch an Object between ‘Active’ and ‘Not Active’. It can 
also be displayed as a counter in Text Geometry. The initial default value is set to zero but 
can be changed in the Options dialog of the Object editor. 

The Formula dialog can be used to change the value of the current or any other Object when
this Behavior is triggered Active. Each line displays the value to be applied to the Object and
the operation to use. The check box must be enable in order to perform each operation. The 
left drop down box is used to define the operation to be used. The right edit or drop down 
box is used to define the new value.

The ‘Current Value’ box is conceptual and intended to help convey that that the Object has a
value when triggered Active. This is a dynamic value that may change on each Activation.

Operations
The left drop down box on each line identifies the operation to be applied between the 
Current and new values. These operations are: 

“Replace” Will Replace the Current Value with the new value.
“Add”: Will Add the new value to the Current Value.
“Subtract”Will Subtract the new value from the Current Value.
“Multiply” Will Multiply the new value with the Current Value.
“Divide” Will divide the Current Value by the new value. The new value may not be 
zero. 

Applied Value
The value to be applied to the ‘Current Value’. Use the right edit box to enter a new 
value. The left drop down box displays the operations that can be applied to the two 
values. 

Get Value
Will get the current value of another Object. Use the right drop down box to select the 
Object to retrieve a new value from. The left drop down box identifies how to apply this 
new value. 

Send Value
The result of the operations on the current value will be sent to another Object. Use the 
right drop down box to identify the Object receiving a new value. The left drop down box 
identifies how to apply the new value to the remote Object. 



Metamorph Dialog (Behavior Editor)

Each Object may contain several components such as Geometry, Shading, Action and 
Behavior. See the section on Understanding Objects for more information. The Metamorph 
operations can be used to change the components of the current Object or any other Object 
when this Behavior is triggered Active.

Change this Object
Check this box if the components of this Object are to be changed. 

Component Selection
Check the box next to each component that is to be changed. Select the new component
from the list in the related drop down box.
 

Additional Object Selection
Identifies external Objects that will have their components changed when this Behavior 
becomes Active. To add an Object to the list select it from the drop down box and press 
the “Include” button. To remove an Object from the list, select it in the List Box and press 
the “Remove” button. 

The “List” box display the Objects that will have their components changed when this 
Behavior becomes Active. Remember to press the “Include” button to add an Object to 
the list.

The “Display” box will help identify Objects by displaying the Geometry of the selected 
Object.



Publish Dialog Sheet

The HTML Publisher provides the following dialog pages:

Profile Select the current Publishing Profile
Pages Select the Project files and options to be published.
File Path Select the destination directory path and options.
FTP Set the FTP server logon requirements 



Profiles (Publish HTML Dialog)

Use the Profile Dialog to create multiple Export definitions for your various projects. One 
profile, for example, may define an export path to a local directory on you computer. 
Another profile may open an FTP session on a remote server so that your Project can be 
exported directly to your web site. 

See the section on Publishing your HTML project for an overview on exporting your project 
into HTML files.

Publish
This button will save all profiles, exit the dialog and Publish the project as specified by 
the currently selected profile.

Apply
This button will save all profiles without exiting the dialog or Publishing the project.

Cancel
This button will exit the dialog without saving the profiles and without Publishing the 
project..

Profile Name
This can be any descriptive name you choose to help distinguish between different 
publishing profiles. The different profiles are available to all your projects. Use the drop 
down box to select an existing or previously defined profile.

New
Use the NEW button to create a new profile.

Delete
Use the DELETE button to delete the currently selected profile.

Export Destination
Select the ‘FTP to Internet Server’ button to create an FTP profile for transferring projects
directly to a server. The ‘Copy to Disk’ button is used to export the project to a directory 
on a local hard drive. 

Clean
Check the ‘Clean unused Objects and Components’ button to cause the program to 
search for orphaned Objects and components prior to exporting a project. This is the 
same operation that is available in the Object_Editor.

Auto Backup
When set, this operation will cause the program to perform an IMS File Save operation 
when the Publish command is initiated.



FTP (Publish HTML Dialog)

The FTP dialog will only be enabled when you are defining an FTP project as set with the ‘FTP
to Internet Server’ button in the Profile dialog. 

IMS provides basic FTP support that is suitable for the majority of users. Some users 
however, may require more advanced FTP capabilities especially if their server is protected 
by a Fire Wall. In these instances we suggest that you export your project to a local hard 
drive on your computer and use one of the numerous advanced FTP products that are 
available.

Host Name/IP Address
A Host Name or IP Address is a unique identifier for a server on the Internet. An IP 
Address takes the form of four numbers separated by “.” such as “123.33.22.1”.

IP addresses are usually mapped to Host Names which are easier for people to identify. 
For example: www.VirtualMechanics.com is mapped to the IP address “216.15.139.237”. 

You must know either your FTP IP address or Host Name to transfer files directly to your 
web site.

User Name
This is the User Name you enter to Log On to your server. This name is provided by your 
Host unless you are using an Anonymous Login.

Anonymous Login
Some servers allow you to make an Anonymous Login. When checked, the User Name 
box will be disabled. Anonymous Logins usually require that you enter your e-mail 
address as your password.

Password
Enter the password provided by your host in order to FTP files to the server. Anonymous 
Logins usually require that you use your e-mail address. 

Save Password
Check the Save Password box to store the password between sessions. If not checked, 
you must reenter the password each time you access this profile.

Remote Port
This is a remote port ID and is normally set to “21”. Some fire walls require a different 
Port ID. Check with your Host administrator if you think this ID needs to be changed.

Retry Attempts
The number of times to retry establishing a FTP connection if the first attempt fails.

Check with your host or system administrator if you are not sure on how to transfer files to 
your web site.



Pages (Publish HTML Dialog)

This dialog allows you to select which pages in the project are to be exported. Each selected 
page will be displayed in the drop down box with the “.htm” file type appended. 

HTML Page Names
Displays the names of all pages in the current project selected for export. These names 
are used to create the HTML files with the “.htm” file type appended to the end. The 
default HTML file name for the current project would be “Page1.htm” unless the user 
changes it. 

To change the name of a page, select the page by pressing the drop down button and 
select the desired page name. Type the new name using 40 or fewer characters into the 
edit box. Avoid using non standard characters such as “!@#$%^&*()<>?” since many 
browser will not interpret them correctly. Page names can also be changed with the 
Page_Editor_Dialog.

Page Range
Select which pages are to be exported. You can select All, the Current Page or a Range of
pages.



File Path (Publish HTML Dialog)

This dialog identifies the output directory and HTML format that will be used for this profile.

Publish Directory
Displays the directory into which the project will be exported. A new directory can either 
be typed directly into the edit window or can be selected with the Browse Button. When 
an FTP profile is selected, you must be online in order to select the directory with the 
Browse Button. If not, the program will attempt to open an FTP connection according to 
the profile settings.

Path Options
Sets the type of path that will be used to reference files in the publish directory.

Absolute: This option will use the full file path including the drive letter to reference 
Script files, Bitmap files and Audio files. This option is convenient when files are 
referenced on multiple drives on the current computer. This option should not be used if 
the project is to be transferred to another system since the file paths may not be valid. 
This option is not available when an FTP profile is selected.

Relative: This option will reference Javascript files, Image files and Audio files with a file 
path that is relative to the publish directory. This option is convenient when HTML files in 
multiple directories reference common resource files. Use this option when publishing a 
large project in multiple directories. The directory structure must be the same on the 
server and authoring system. Use the HTML Target Dialog to locate “vmmech.js” in a 
different directory.

Gather: This option will gather all referenced Javascript, Image and Audio files into the 
publish directory. This is the safest option with the least risk of missing resources. Use 
this option when publishing a small project or when an FTP profile is selected.

Format
Select Basic HTML, HTML 3.2 or Dynamic HTML 4.0 compatible output. You must select 
Dynamic HTML 4.0 if you wish to include animation. These files will still be compatible 
with 3.2 Browsers but will not display Dynamic HTML capabilities. Select HTML 3.2 when 
the project does not include any DHTML operations. Output into 3.2 format is 
significantly more compact than 4.0 output. Basic HTML will create output that is 
compatible with the majority of Browsers but without the page layout capabilities offered
in 3.2 and later browsers. IMS products are not intended for authoring Basic HTML.

Combine Output (DHTML only)
Will combine the DHTML project Javascript file with each HTML file. When not selected, a 
single Javascript file will be created with the name of the first page in the project that will
be shared by all pages in the project. When selected, the Javascript data for each page 
will be appended to the end of each HTML file. 

Selecting Combined Output    has the advantage of simplifying the publishing process by 
eliminating the extra Javascript file. It will also improve the initial download performance 
of the project by reducing the amount of data that must be downloaded before the 
completed first page is displayed.

When Combine Output is not selected, all Javascript data for the project will be included 
in a separate Javascript file that must also be copied to the server with the HTML file. 
This has the advantage of reducing the total amount of data used by the project when 
multiple pages Include the same components. 



Export Bitmap (Export Bitmap Dialog)

This dialog provides the ability to select an Object or a range of Pages to be exported as 
bitmaps. After selecting OK, IMS Web Engine will display the Save As dialog box whereyou 
can input the name of the file you are exporting to, as well as the type of the file. The format
of the file is determined by the file type extension. Valid file types include GIFF “.gif”, JPEG 
“.jpg” and Windows Bitmap “.bmp”.

Export Image Dialog
The following options allow you select an Object or Page and an Image format.

Object
Specifies that an Object is to be exported as a bitmap image. Select the desired object 
from the Combo Box drop down list.

Pages
Specifies that the selected Pages are to be exported. Select the current page, all pages 
or a page range.



Background Dialog (Page Background Dialog)

Selects a color and/or a background image for the current page.

Fill Color: 
Three adjustable sliders for setting the RGB values of the background color.

Color: 
Will set the page to a solid fill monochrome background    and will display the standard 
color selection dialog.

Tile: 
Will display the standard file open dialog to select a valid image file. The image will be 
repeated to fill the screen background. Valid file types include “.gif”, “.jpg”, “.bmp” and 
“.png” amongst others.

Image: 
Will display the standard file open dialog to select a valid image file. The image will be 
placed at the top left of the screen. The unfilled portion of the background will be filled 
with the background color. Valid file types include “.gif”, “.jpg”, “.bmp” and “.png” 
amongst others.



Page Editor Dialog 

The Page Editor provides the following dialog pages:

Select Select the current Page.
Title Sets the Page title and meta tags
Link Sets a timed Page link.



Options Dialog (Page Editor)

Name: 
Displays the name of the current Page being edited. Use the drop down box to edit 
another Page. 

You can change the name of the current Page by typing a new name into the edit box. 
Page names must contain ten or fewer characters, must not start with an alphanumeric 
character and must not contain any blank or special characters. By default, names will 
be assigned as: Page1, Page2. Page3 etc. 

When the Publish HTML command is used, the page name will be used as the HTML file 
name unless changed.

Current Setting: 
Will display a thumbnail of the current page.

Create: 
Appends a new blank page to the project.

Delete: 
Deletes the current Page. If there is only one page in the project, the program will offer to
empty it of all content but will not delete it.



Title Dialog (Page Editor)

Sets HTML file Title and Meta Tags in the <HEAD>. The correct use of these elements can 
greatly improve a pages ability to be found and positioned by search engines. 

Page Title: 
This string will be entered as the <TITLE> element of the HTML file. The title element is 
often used by search engines and the browser to identify the HTML document. Your title 
should consequently be clear, descriptive and relatively short.

If a title is not entered, IMS Web Engine will substitute the page name.

Meta Description: 
Provides the contents for the HTML document Meta description tag. This tag is often used
by search engines to describe the contents of the HTML document. You should use many 
of the words in your Meta Keywords to describe the contents of the page.

Meta Keywords: 
A list of words separated by commas to help search engines locate and index the 
contents of the page.



Link Dialog (Page Editor)

This function provides the ability to dynamically link to a new HTML document after a 
specified time interval. 

Link to URL: 
When checked, this option will link to the URL entered into the edit box. Any valid URL 
may be entered.

Link to Page: 
When checked, this option will link to another page in the current project. Select the 
page from the drop down box. IMS Web Engine will substitute the correct URL for the 
page when the project is exported.

Unvisted Color: 
Is used to set the color of unvisited URL links. Selecting this button will display the 
standard color editor.

Visited Color: 
Is used to set the color of    previously visited URL links. Selecting this button will display 
the standard color editor.

Timer in Seconds: 
When checked, specifies the amount of time to wait in seconds(approximate) after the 
HTML page has loaded before linking to the new page. Use the slider or enter a value 
directly into the edit box.



Page Music (Page Music Dialog)

This dialog can be used to define background music for the current page. Background music 
is played by passing the location of an audio file to the Browser Audio player with either the 
<embed> or <bgsound> tags. The specific audio file formats supported by the Browser may
vary or change from time to time. It is expected that MIDI, Wave, AU and AIFF will normally 
be supported. MIDI (Musical Instrument Digital Interface) audio files are generally preferred 
for their compact file sizes when playing digital compositions.

Select New: 
Will display the standard file open dialog to select an audio file. You must also check the 
‘Enable music’ box play an audio file.

Enable Music: 
Check to enable playing the selected audio file. When unchecked, the selected audio file 
will be ignored.

Continuous Play: 
When checked, the selected audio file will play continuously while the HTML page is 
displayed. When unchecked, the audio file will play once and then stop.



Shading Dialog Sheet

The Shading Editor provides the following dialog pages:

Selection Select the current shading component.
Attributes Selects the fill color or pattern.



Selection Dialog (Shading Editor)

Name: 
Displays the name of the current Shading component being edited. Use the drop down 
box to select another Shading component. 

You can change the name of the current Shading by typing a new name into the edit box.
Shading names must contain ten or fewer characters, must not start with an 
alphanumeric character and must not contain any blank or special characters. By 
default, names will be assigned as: Shad1, Shad2. Shad3 etc. 

Current Setting: 
Will display the color or pattern of the current page.

Create: 
Creates a new Shading component.

Delete: 
Delete the current shading component. IMS Web Engine will test all Objects for reference 
to this shading and replace them with a null reference.



Attribute Dialog (Shading Editor)

Fill Color: 
Provides 3 sliders to select the RGB component of the shading background. When a solid 
color fill is selected, this color will fill the entire geometry. When an image pattern is 
selected, this color will fill the portion of the geometry not covered by the image.
 

Color: 
Will select Solid Fill shading. This button will also display a standard color menu. The fill 
color can be set with either the color menu or with the RGB sliders. 

Image: 
Will select Image Fill shading. This button will display the standard File Open dialog. 
Select a valid image file type (GIF, JPEG, BMP etc.) and file path. The Image fill will be 
optimized to fit the dimensions of the geometry while maintaining the images aspect 
ratio. Unfilled portions of the geometry and transparent pixels in the image will be 
replaced with the Fill Color. 

Texture: 
Will select Texture Fill shading. This button will display the standard File Open dialog. 
Select a valid image file type (GIF, JPEG, BMP etc.) and file path. The Image fill will be 
stretched to fit the dimensions of the geometry. Transparent pixels in the image will be 
replaced with the Fill Color. 



Preview menu commands

Preview Bar:

The Preview menu provides the following commands:

3.2 Page Preview the current page in 3.2 HTML format.
3.2 Project Preview all pages in 3.2 HTML format.

4.0 Page Preview the current page in DHTML 4.0 format.

4.0 Project Preview all pages in DHTML 4.0 format.

Preview Page HTML 3.2 command (Preview menu)

Previews the current page in a HTML 3.2 compatible format. HTML 3.2 does not play 
animation. See Understanding the IMS Web Engine Page. for more details.

Select the Close Button  on the Browser title bar to return to IMS Web Engine when you 
have finished the preview.

Shortcuts
Preview Bar:



Preview Project HTML 3.2 command (Preview menu)

Previews the current project in a HTML 3.2 compatible format. HTML 3.2 does not play 
animation. See Understanding the IMS Web Engine Page. for more details.

Select the Close Button  on the Browser title bar to return to IMS Web Engine when you 
have finished the preview.

Shortcuts
Preview Bar:



Preview Page DHTML 4.0 command (Preview menu)

Previews the current page in a Dynamic HTML 4.0 compatible format. DHTML 4.0 plays 
animation. See Understanding the IMS Web Engine Page. for more details.

Select the Close Button  on the Browser title bar to return to IMS Web Engine when you 
have finished the preview.

Shortcuts
Preview Bar:



Preview Project DHTML 4.0 command (Preview menu)

Previews the entire project in a Dynamic HTML 4.0 compatible format. DHTML plays 
animation. See Understanding the IMS Web Engine Page. for more details.

Select the Close Button  on the Browser title bar to return to IMS Web Engine when you 
have finished the preview.

Shortcuts
Preview Bar:



Text Geometry (Text Dialog)

IMS Web Engine uses a standard style text dialog to create, edit, import and export text in 
several different format styles. The dialog can be maximized or scaled by dragging the 
bottom right corner. 

When a Rich Text or HTML Text Object    is saved, the same dimensions that were set when 
the Text Object was loaded will be retained. If a new Text Object is created, a standard 
100x100 rectangular box will be defined. Move and scale the box as desired. 

Plain text Objects will be bound by a box that fits the text.      You can scale Plain text Objects 
to any point size by dragging the Object’s bounding box on the Y axis. Plain text will not 
wrap on the x axis. You must enter a carriage return to create multiple lines when using plain
text.

In this version, the Text Editor tool bars are fixed and can not be moved. See the section 
Understanding Text for more details on using text.

The Text Editor buttons perform the following operations:

    Word Processor
This button will attempt to open the default system Word Processor if one is available. 
This is assumed to be the application attached to files of type “.rtf”. A different file type 
can be assigned from the Options -Settings menu.

Text entered into a word processor can be transferred through the clip board. Select and 
copy the text to be transferred in the word processor then open the IMS Text Editor 
window and paste into the text window. You can use Ctrl-C and Ctrl-V    to cut and paste 
or use the Cut and Paste buttons in each application. You can also save the word 
processor into a “.rtf” file then load it into IMS with the Open button. You can switch 
between the two applications by selecting the application button on the system toolbar.
    New Button
Will create a new blank Text Geometry and Object. If an existing Text Geometry is being 
edited, you will be prompted to save it first.
    Open Button
Use this button to import an existing text file. This command will display the standard file
open dialog. Supported file formats include: (.rtf) Rich Text, (.txt) Plain Text, (.htm,.html) 
HTML files. The extension will determine the format of the imported file. Unrecognized 
extensions will be imported as Plain Text. 
    Save Button
Use this button to save the Text Geometry to its current name and directory.    When you 
save Text for the first time, the program displays the Save As dialog box so that you can 
name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As button.
    Save As Button
Use this button to display the Save As dialog  so that you can name your document. The 
file will be exported in the format set by selecting the file extension. Valid formats 
include (.rtf) Rich Text, (.txt) Plain Text, and (.htm,.html) HTML.
    Cut Button
Use this button to cut the selected text and copy it to the clipboard.



    Copy Button
Use this button to copy the selected text to the clipboard.
    Paste Button
Use this button to insert text from the clipboard. Text saved in external editors can be 
copied and pasted into the IMS Text Editor.
    Undo/Redo Button
Will Undo/Redo the last edit operation.

Name Geometry Combo Box
This combo box will display the name of the current text Geometry. Select and edit to 
change the name. Geometry names must contain 10 or fewer character, should not start 
with a number and should not contain any blank or special characters.

The drop down box contains the list of all Text Geometry. A new Text Geometry may be 
selected from the list for editing.

Text Style Combo Box
This combo box contains the text format styles supported by IMS Web Engine. These 
include: Rich Text, Plain Text, HTML and Counters. A warning will be displayed if you 
change styles. Once a style has changed, special formatting for the previous style will be
lost.

Only Rich Text supports inline formatting. All other styles will apply formatting to the 
entire Text Geometry. See the section on Understanding Text for more details on text 
styles.

Font Face Combo Box
Use this box to select a font face. When Rich Text formatting is being used, the font face 
will be applied to the selected text. All other styles will apply the font to the entire text.

The combo box will display all font faces available on the current system. Care should be 
taken to select a font that will be appropriate for visiting browsers.
 

Font Size Combo Box
This box display’s the font sizes available in the exported HTML. document. When Rich 
Text formatting is being used, this button will set the size of the selected text when it is 
displayed in the browser. All other formats provide the ability to set the font height by 
dragging the Text Object’s bounding box on the Y axis.

See the section on Understanding Text for more details on text styles.
    Bold Button
Use this button to select bold text. When Rich Text formatting is being used, bolding will 
be applied to the selected text. All other styles will apply bolding to the entire text. 
    Underline Button
Use this button to select underline text. When Rich Text formatting is being used, 
underlining will be applied to the selected text. All other styles will apply underlining to 
the entire text. 
    Italic Button
Use this button to select italic text. When Rich Text formatting is being used, italicizing 
will be applied to the selected text. All other styles will apply italicizing to the entire text. 



    Justify Left Button
Use this button to set line justification to the left. When Rich Text formatting is being 
used, justification will be applied to the selected lines. All other styles will apply 
justification to the entire text.
    Justify Center Button
Use this button to set line justification to the center. When Rich Text formatting is being 
used, justification will be applied to the selected lines. All other styles will apply 
justification to the entire text.
    Justify Right Button
Use this button to set line justification to the right. When Rich Text formatting is being 
used, justification will be applied to the selected lines. All other styles will apply 
justification to the entire text.
    Color Button
Use this button to select text color. When Rich Text formatting is being used, color will be
applied to the selected text. All other styles will apply color to the entire text. This 
command will display the standard color dialog.



Tool Options Dialog (Options Menu)

Tool Bars
The left hand check boxes can be used to make various tool bars visible or hidden. The 
right hand check boxes are used to select large or small tool bars. Tool bars can be 
dragged to any screen location desired. See the View menu for more details on the use 
of Tool Bars.

Snap Grid
Sets the snap grid resolution. When the snap grid is enabled, the cursor position will be 
forced to operate at the set intervals on the X and Y axis. The snap grid is useful for 
transforming and aligning Object on the work window. See Working in the IMS Window for
more details.

Shortcut Key: CTRL+M

Freehand Drawing Resolution
Freehand sketching is accomplished by holding the left mouse button down while 
drawing a Shape polygon. When freehand drawing, IMS Web Engine will add points to the
polygon at equal distances. Use this slider to adjust this distance. See the Shape 
command. for more details on shape geometry.

Set Word Processor file type
Can be used to set the default Word processor file type from “temp.rtf”. This file is used 
by the Word Processor command of the Object menu to attempt to open the default 
system word processor. If    "temp.rtf" fails you can try "temp.doc", "temp.txt" or 
"temp.eml" amongst others. Select the drop down button to locate a file with the File 
Dialog.



HTML Target Dialog (Options Menu)

This dialog sets options for assisting in the production of the project. Actual HTML output will
not be affected by these settings.

Set Target Resolution
Will set the Guide Border dimensions according to the target resolution of a visitor’s 
computer screen. The border can be used to help determine what portions of the screen 
will probably be viewable.

Locate vmmech.js
When Exporting a Dynamic HTML project with the Relative file option, “vmmech.js” is 
referenced in the “/bin” subdirectory. Use this Edit window to locate “vmmech.js” in a 
different directory. 

When you ‘ftp’ your finished project to your server, you must also ftp “vmmech.js” for 
Dynamic HTML    projects. When the Gather file option is used, “vmmech.js” is copied to 
the same directory as the Exported HTML file. When the Relative file is option is selected,
“vmmech.js” should be copied to the same directory that is specified here. 

See the section How to Publish your HTML for more details.

Set Target Browser
Select if the project is being designed for a 3.2 HTML browser or a 4.0 DHTML browser. 
This option is used to provide warning messages.



Select Word Processor File Type (Options Menu)

This dialog is used to set the default Word processor file type from “temp.rtf”. This file is 
used by the Word Processor command of the Object menu to attempt to open the default 
system word processor. If    "temp.rtf" fails you can try "temp.doc", "temp.txt" or "temp.eml" 
amongst others. 

Set File Type
Type a filename to be used to open the Word Processor. The drop down box will open the 
default File Dialog to locate a file of the desired type on your computer.

Do Not Display
Check this box to prevent the dialog from being displayed when the Word button is 
selected in the Object menu.



Sound Dialog Sheet

The Sound Editor provides the following dialog pages:

Selection Select the current sound component.
Settings Selects an audio file and repeat count.



Selection Dialog (Sound Editor)

Name: 
Displays the name of the current Sound component being edited. Use the drop down box
to select another Sound component. 

You can change the name of the current Sound by typing a new name into the edit box. 
Sound names must contain ten or fewer characters, must not start with an alphanumeric 
character and must not contain any blank or special characters. By default, names will 
be assigned as: Sound1, Sound2. Sound3 etc. 

Assigned Objects: 
Will list all Objects currently using this Sound component.

Create: 
Creates a new Sound component.

Delete: 
Delete the current sound component. IMS Web Engine will test all Objects for reference 
to this sound and replace them with a null reference.



Settings Dialog (Sound Editor)

Select New: 
Will display the standard File Open dialog to select an audio file. The primary file type for 
sound effects are “.wav” Other file types may also be used if supported by the browser.
 

Repeat Plays  
Use this Slider or Edit box to set the number of times the sound effect is to be played.    
The default is 1.

Continuos Play: 
Check this box to select continuos Play. The sound effect play repeat forever. 

Note: You can use a behavior to accurately control starting and stopping a sound effect. 
These include Button Sounds and game playing sounds. 



Introduction to IMS Web Engine ™

 ™

© Copyright 1998 by Virtual Mechanics Inc.

IMS (Interactive Multimedia System) is a WYSIWYG (What You See Is What You Get) drag and 
drop authoring application for the creation of both HTML 3.2 and Dynamic HTML 4.0 and 
above, web pages. Applications range from the creation of standard Web Pages, Business 
Presentations, Educational Presentations to Online Interactive Games.

"IMS Web Engine" is designed to create Web Pages that include complex event driven 
animation with a simple drag and drop user interface. Features include Inverse Mechanics 
and Artificial Behavior which means    that motion paths can be attached to motion paths in a
hierarchical    fashion. Event Triggers (Behaviors) can be defined by more than simple Mouse 
and Timing    Events and    can include amongst others: Object Intersection, Object Triggers,    
Advanced Counter Triggers, Metamorph operations or Combinations based on Logical 
AND/OR flags.

Other features include a TEXT, HTML and Rich Text editor that also    supports conversion 
between these formats and the ability to import/export these formats from other popular 
text editors. HTML can be imported, manually edited and used without any modification by 
the program.

In addition to creating motion paths the Vector/Polygon editor can be used to create buttons 
and graphics with texture maps. "IMS Web Engine" supports the import/export of several 
popular bitmap and audio formats include GIF, JPEG, BMP, WAV and Midi. The program can 
also be instructed to gather all files together into the publish directory to substantially 
minimize the occurrence of missing objects in the web page.

IMS Web Engine is an Object Oriented application written in C++ with Java and Javascript 
components. 



Introduction to IMS Web Spinner™

 ™

© Copyright 1999 by Virtual Mechanics Inc.

IMS (Interactive Multimedia System) Web Spinner is a WYSIWYG (What You See Is What You 
Get) drag and drop authoring application for the creation of HTML 3.2 and above, web 
pages. Applications range from the creation of standard Web Pages, Interactive web pages, 
Personal Web pages and Store Fronts.

Features include Mouse Over events to dynamically switch text and/or images as the mouse 
is positioned over an element; a TEXT, HTML and Rich Text editor that also    supports 
conversion between these formats and the ability to import/export these formats from other 
popular text editors. HTML can be imported, manually edited and used without any 
modification by the program.

The    Vector/Polygon editor can be used to create buttons and graphics with texture maps. 
"IMS Web Spinner" supports the import of several popular bitmap and audio formats include 
GIF, JPEG, BMP, WAV and Midi. The program can also be instructed to gather all files together
into the publish directory to substantially minimize the occurrence of missing objects in the 
web page.

IMS Web Spinner is an Object Oriented application written in C++ with Java and Javascript 
components. 



Copyright Notice

 ™

© Copyright 1998 by Virtual Mechanics Inc.

Notice of Proprietary Property

IMS Studio, IMS Web Engine, IMS Web Spinner and “Interactive Multimedia System” are all 
trademarks of    Virtual Mechanics Inc.. All manuals, documentation and other support 
materials regardless of medium are the proprietary property of Virtual Mechanics. Any 
proprietary property of other companies whose products have been licensed to Virtual 
Mechanics and are used in programs contained on this disk, such as fonts, sound effects, 
music, animation, clip art or otherwise, remain the property of those companies. You agree 
not to remove or deface any such notifications of proprietary restrictions from any Virtual 
Mechanics products contained herein.

It is strictly forbidden to reverse engineer, attempt to reverse engineer, decompile, or 
otherwise make use of any part of the core code that constitutes IMS Studio or the code 
contained in any of its applications including but not limited to “IMS Web Spinner” and “IMS 
Web Engine”. Any such activity will result in criminal prosecution and the pursuit of 
damages.

You may not lend or rent these products; use any of the proprietary materials included in 
this package, except in the intended purpose of these products; duplicate, replicate, or 
distribute any of the products contained in this package in any fashion except as allowed by 
this agreement. This includes, but is not limited to, all manuals and other printed material, 
demonstration files, and help guides.

Rights Granted to Users

These products are licensed to you for use on one computer. Use of the products on more 
than one computer is forbidden and requires the licensing of a number of products equal to 
the number of computers the products are to be used on.

You may make one copy of the products contained on this disk for the purpose of backup 
only. Carefully read these Warranty and Registration terms before installing IMS Web Engine 
or IMS Web Spinner. Installation of any or all these products indicates your acceptance of the
terms and conditions described.



Contacts and Support

Technical Support:
Technical support is available through our mailing lists and news letters by registering 
your product at http://www.VirtualMechanics.com/support/register.htm.

Documentation:
Corrections and suggestions regarding any aspect of this documentation should be 
addressed to doc@VirtualMechanics.com.

General:
Please address any comments, criticisms or requests for general information about 
Virtual Mechanics and its products to info@VirtualMechanics.com



Register your Software

You may register your trial IMS application by selecting the Purchase Button under the 
Help menu or by visiting the Virtual Mechanics registration page at 
http://www.VirtualMechanics/purchase.htm



IMS Project Files

The IMS files contain the instructions that describe the users HTML project. An IMS project is 
saved in a binary format and is consequently not readable or editable outside of the IMS 
application program. IMS files are extremely compact and can be converted to several 
different standard formats including: HTML, Dynamic HTML, VRML and numerous other 
formats.
When the Export HTML command is selected, the internal IMS Format is converted to either 
HTML or Dynamic HTML..

Loading and IMS Project
An IMS project can loaded with the Open command in the File Menu or File Toolbar. The 
File Menu also contains a list of the four most recent projects.

Saving and IMS Project
An IMS project can be saved with the SAVE or SAVE AS commands in the File Menu or File
Toolbar.

Project Backup
A Backup IMS file of the current project is made automatically whenever a project is 
loaded or Saved. This backup file called “IMSBackup.ims” is saved into the main IMS 
install directory and is deleted whenever the project is terminated normally.

Error Recovery
An IMS project can be restored to the last Save with the ‘Restore Last’ command in the 
File Menu. A project can be Recovered from the “IMSBackup.ims” file with the ‘Recover 
Previous’ command in the File Menu.

Crash Recovery
When an IMS session is terminated abnormally through a system or other failure, the 
“IMSBackup.ims” file will not be deleted. When an IMS Application is first started, it will 
search for the backup file and will display a dialog giving the user the opportunity to load
the last successful save from the failed session. 



Understanding Objects

Object Bar 

Objects are the principal elements displayed on a Page and can be positioned, edited and 
animated. An Object is a combination of components with a transformation matrix and a 
value associated with it. The current Object and its components are displayed in the Object 
Tool Bar. The first edit box of the Object Bar displays the name of the Object. The following 
edit boxes display the names of the components that are contained within the Object. These 
components include:

Geometry
Geometry is a collection of 2D vertices that describe a shape or motion a path. The 
different types of Geometry include: Rectangle, Ellipse, Polygon, Sprite and Text. An 
Object will have no visible geometry unless it also has a shading component.    Sprites 
and Text are rectangle geometry with a shading component included in the Object. 

Shading
Shading describes the visible component of an Object’s geometry. The types of shading 
available include: Solid Color, Texture Map and Pattern Map. A sprite is rectangular    
geometry with a texture map. Text is rectangular geometry with solid color shading.

Sound
This version of IMS Web Engine does not include a Sound Component in an Object. 

Action
Action describes the motion an Object will have. The available actions include: Linear 
Paths, Interactive Mouse Control and Hierarchical Motion Paths.

Behavior
The Behavior component describes a collection of Interactive and Dynamic Triggers and 
Events. You can assign behaviors to construct complex scenarios. 

An Object also includes two unique elements. These are its Transformation Matrix and Value.

Transform Matrix
In IMS Web Engine, geometry is created in its own coordinate system. An Object’s 
transformation matrix controls the geometry’s position, size and rotation. This technique 
has the advantage in that any Geometry only needs to be created once and can be 
transformed and displayed by many Objects. The Action component of an Object is used 
to create motion by dynamically changing the Objects transform matrix in the finished 
presentation.

Value
Every Object has a unique integer value associated with it. The initial value is set to zero 
by default. This can be modified with the Object Options dialog. An Objects Value can be 
dynamically modified by any Behavior. See the Behavior Formulas. An Objects Value can 
be used as a text counter with the Text_Editor or to trigger behaviors with the 
Behavior_Editor.

This Object method provides several unique advantages to an interactive authoring 
application. Some of these include:

· Common components such as motion paths and URL links need only be created once.
Updates will be applied to all objects that share the component. Changing an 
incorrect URL for example, will change all references to it throughout the entire 



project.

· Sharing elements will reduce HTML file sizes, a significant issue when potentially 
large DHTML files are involved.

· Dynamic updating means that any component can be changed by any event. A click 
of the mouse might change an objects motion path while intersecting Objects my 
change the bitmap of one Object to a completely different picture.    



Understanding Actions

In IMS Web Engine, every Object has a transformation matrix that describes the Object’s 
position, scale and rotation(only vector Geometry can be rotated). An Object can be 
animated by modifying its transformation matrix over time. The principal means of doing 
this is to include an Action component with the Object.

The Action component uses several techniques to describe motion. The first of these is 
through the use of Linear Paths. The second technique uses Interactive input by tracing the 
movement of the mouse. The final method is through the use of hierarchical motion paths.

Linear Paths
A linear path provides a simple means to describe motion in one of eight directions. Each
direction is based upon a compass point and a location dependent upon the Object’s 
position at the start of the presentation.

Interactive Mouse Input: 
Interactive Motion is tied to the movement of the mouse on the X and/or Y axes. When 
only one axis is used, the Object will stay positioned at its original position on the other 
axis. 

Hierarchical Motion Paths: 
The Geometry of any Object can be used to define a path for another Object. The 
principal means of describing a path is through the creation of a Rectangle, Ellipse or 
Shape that is a component in another Object. Text and Sprites can also be used as 
Rectangular paths.

Hierarchical motion results when an Object traces the path of another Object with an 
Action component. In this way, Object_A can trace Object_B which is tracing Object_C 
and so on. There is no theoretical limit to the depth of this hierarchy. Care should be 
taken to prevent recursive hierarchies which will result in unpredictable motion.

In addition to providing motion, the Action component provides a Rate to determine speed, a
Repeat counter to determine how many times a path should be traced and an Orientation 
option that will dynamically change an Objects geometry as its direction changes. 

An Action component can be created with the Action Editor dialog.



Understanding Behaviors

IMS Web Engine provides a Behavior component that may be attached to an Object. In IMS 
Web Engine, a Behavior is a complex interrelationship between dynamic events and actions.

At its simplest, a Behavior may define a mouse click that makes an Object toggle between 
visible and invisible. At its most complex, a Behavior may be triggered only when a 
predefined set of events(related or not) are true. Such an event trigger may results in the 
Object changing its Behavior so that a different set of events are needed to trigger a new 
action.

A Behavior can be in one of two states. These are ‘Active’ and ‘Not Active’. The distinction 
between the two states is defined by the user and should not be construed by the name. For
example, a Behavior may impart Visibility and Motion when ‘Not Active’ and Invisibility with 
no Motion when ‘Active’. The switch between the ‘Active’ and ‘Not Active’ states is 
determined by a set of Event Triggers.    Three types of Event Triggers are possible. These are
User Events, Dynamic Events and External Events.

User Events
Caused by a user interaction such as a mouse selection or keyboard entry. 

Dynamic Events    
Caused by a dynamic event such as a Timer, Object Intersect, Counter etc.

External Event
Caused by an external event such as another Object triggering this Behavior into its 
‘Active’ or Not Active’ state.

Event triggers may be combined with the logical AND / OR operators to create more 
complex combinations of triggers. Extremely complex triggers may be created by the careful
use of Object formulas. In a game, for example, a Behavior may be created to display a 
message only if a sequence of events occur in a predefined order. By applying formulas from
the Event Behaviors to the Message Behavior, a unique number could be created to trigger 
the Message Behavior.

When an Behavior switches between the two states, it has an opportunity to perform unique 
operations. These include Links, Actions, Formulas and Metamorph.

Links
When entering the Active state, a Behavior may link to another URL..

Actions
Are available when either Active or Not Active. These include: Visibility, Motion, External 
Triggers and Resets.

Formulas
When entering the Active state, a Behavior may perform a math operation on the Value 
of any Object.

Metamorph
When entering the Active state, a Metamorph is the ability for a Behavior to change the 
components of any Object. These include changing an Objects Geometry, Action and/or 
Behavior.

For details on creating and setting Behaviors see the Behavior_Editor dialog.



Understanding Text

In IMS Web Engine, text is treated just like any other Geometry component of an Object. An 
Object that contains text geometry can consequently be transformed, have Behavior and 
Action. For more details on Objects see the section Understanding Objects.

Text is created or imported with the Text_Editor. IMS Web Engine supports several different 
styles of text. These are:

Plain Text (.txt files)
Plain text does not include inline formatting. Plain text can be assigned a single color, 
font style and font size. In the IMS Window, the string can be scaled to any size by 
dragging the ‘size handles’ on the Y axis.    Plain text is useful for creating Titles, Banners 
or blocks of text that use a single size, color and font.

Rich Text (.rtf files)
Rich Text is supported by the majority of Word Processors. This format provides basic 
inline formatting including: font faces, font sizes, justification, bolding etc. and is 
consequently useful for importing large documents from external word processors. In the
IMS Window, the characters will maintain their font size regardless of how the Object is 
scaled. Word wrapping is controlled by the width of the Object bounding box. Increase 
the width to make longer lines, decrease to make narrower columns.

HTML (.htm files)
HTML in IMS Web Engine is treated as a raw format. This is useful when you wish to 
import or write HTML without being concern that it may be modified by the program. IMS 
Web Engine will export this HTML between <DIV> </DIV> tags in the Body of the HTML 
file. Care should consequently be taken not to include tags or controls that will interfere 
with the HTML output of IMS Web Engine. Examples would be including <BODY> or 
<HEAD> tags in the text HTML.

Counters
A counter is a special format for displaying the Value of the current Object. Every Object 
has a unique value associated with it. See Understanding Objects for more details. When 
this format is selected, IMS Web Engine will attempt to substitute the text string with the 
current Value of the Object using the selected Plain Text formatting values. 

Currently not all browsers support this capability. If the browser can not replace the text 
string, the current value will be displayed on the browsers’ Status Bar.



Understanding Groups
 
A Group is a collection of Objects that can be manipulated and edited as a single Object. A 
Group Object contains a Geometry component of type Group.

Two types of Group Objects are available. These are a temporary group and permanent 
groups. 

Temporary Group
A temporary group is created by dragging a bounding box completely around two or 
more objects. When the user releases the mouse button a bounding box will snap around
all objects in the group. The bounding box will display edit handles to provide the ability 
to move, scale and stretch the temporary group as a single Object.

When a temporary group is created, the Arrange menu commands and Arrange Arrange 
Bar buttons will be highlighted and available. Use these operations to align and position 
the members of the Group Object relative to each other.

Unless a temporary group is converted into a permanent group, the temporary group will
be destroyed as soon as any operation outside of the group is performed.
        

Permanent Group
A temporary group can be converted to a permanent group by selecting the Group 
command or button. A permanent group is an Object with geometry of type Group. When
displaying a Group Object IMS Web Engine recursively traverses all members of the 
group until they are resolved into non-group geometry. In this way it is possible to 
combine any combination of group and non-group Objects.

A Group Object can be manipulated and edited as a single Object. For example, a Group 
Object can trace a path and have Behaviors associated with it. When there is a conflict 
between the components of the Group Object and components of the Objects contained 
within the group, the Group Object components will take precedence. 

A Group Object can be converted back to its constituent Objects with the Ungroup 
command or button.

For more information about Objects, see the section Understanding Objects..



Understanding Pages

Page Bar 

In IMS Web Engine, a Page primarily provides a container to display and position Objects on 
a background. A Page can also contain audio. When a project is Exported 
HID_HOWTO_EXPHTML each Page in the project is converted to a HTML document. A project 
may contain as many Pages as desired.

The Page Toolbar provides commands for creating and editing pages in the current project. 
Two Edit boxes display elements of the current page. The first edit box displays the page 
name. You can move to any page in the project by selecting the Page from the drop down 
box. The second edit box displays all Objects that are included in the current page. You can 
use the drop down box to select and highlight an Object. Page names and other page 
options can be changed with the Page_Editor dialog.The Page_Background  dialog can be 
used to select a new background color, image or tile pattern. The Page_Music dialog can be 
used to assign music to the current page. 

Several commands are also available to cut, copy, paste and append a page. When a Page is
pasted, all Objects in the parent page will be Included in the new page. See below for 
information on Included Objects. Insert and Append will add a new blank page to the project 
relative to the current page. Page order however is not important since links between pages 
can be defined in any sequence.

When an Object is Cut or Copied, it may be transferred between pages in one of several 
methods. The method used can be significant depending upon the users objective. See the 
section Understanding Objects for more details on this topic. These methods are:

Paste Copy: 
When an Object is Paste Copied to a Page, the Object and all its components will be 
duplicated to create a new Object and components. This new Object and its components 
will then be completely independent of the parent Object. Changes to this Object or its 
components will have no effect on the parent Object.

Paste Cloned: 
When an Object is Paste Cloned to a Page, a new Object will be created but it will 
reference the same components as the parent Object. The new Object can be 
transformed (position, rotate, scale) independently of the parent. Components such as 
Behavior and Action will affect both Objects in the same way. Changing a component that
is common to both Objects will affect both Object.

Include: 
An Object may be Included on more than one Page. An Included Object is the SAME 
Object as the parent including its transformation. Moving an Object on a Page will move 
it on every page that it has been included in. Included Objects are useful for titles, tables 
of contents, logos, links or any other elements that appear across multiple pages on a 
web site.

You can preview the presentation in your default browser at any time with one of the four 
Preview menu buttons. When you preview your project, IMS Web Engine will copy all 
referenced files and create a HTML document of the selected pages in your project and place
them into the \preview sub-directory of your main installation. The files in this directory are 
only used on a temporary basis and can be deleted at any time. The directory however, is 
necessary and must not be deleted or changed.



Using the IMS Window (How To)

The IMS Work Window provides a surface upon which the user can Drag and Drop Objects to 
create a web page. IMS Web Engine provides numerous aids and guides for composing the 
Page.

Selecting Objects:
Each Object has a bounding box around its geometry. When an Object is selected by 
clicking within the bounding box, the box will become visible. IMS Web Engine uses a 
“Last Selection Preference” technique. This means that the last Object selected will be 
given preference when selecting within its bounding box even if the Object is hidden 
behind another Object. This simplifies positioning and transforming Objects that may be 
covered by closer Objects.

To select an Object behind the current Object, hold the Shift Key while selecting. To select
the Object that is in front of all other objects, hold the Ctrl Key while selecting.

Transforming (Moving, Scaling, Rotating) Objects:
Object transformations include: moving, scaling and rotation. 
· An Object can be moved by selecting and dragging it to a new position with the 

mouse. An Object can also be nudged into place with the arrow keys. 
· Scaling is performed by selecting a bounding box handle and dragging it to a new 

size. Hold the Shift button down when scaling to maintain the aspect ratio of the 
Object. Controlled stretching can also be performed with the arrow keys while holding
the shift button down.

· Rotation is performed with the arrow keys while holding the Ctrl key down. Only 
vector based Geometry including rectangles, ellipses and shapes can be rotated.    

Precise Object transformations can also be performed with the Object Editor
Moving Objects on the Z axis

Objects are displayed In-Front off, or Behind off, other Objects according to their position 
on the Z axis. Z axis positioning is initially determined by the order in which an Object is 
created. The first Object will be at the back while the last Object will be at the front. The 
Object order on the Z axis can be changed with the Forward/Reverse commands of the 
Arrange menu.

Right Mouse Button:
The right mouse button can be used to select an Object and display the Object Editor. If 
the right mouse button is used without selecting an Object, The Page editor will be 
displayed.

IMS Web Engine also provides numerous guides to help compose your page. These include:
Display Grid:

The display grid provides a guide to help position Objects vertically and horizontally. This 
grid can be toggled on and off with the Options Grid command or “Ctrl G” shortcut.

Snap Grid:
A snap grid is available to force the mouse position to be restricted to periodic intervals. 
This interval can be adjusted with the Snap Grid slider in the Tool Options dialog. The 
Snap Grid can be toggled on and off with the Options Enable_Snap Grid command or 
“Ctrl M” shortcut.

Guide Border:
The page guide display’s the target outline as set by the Set HTML Options dialog. This 
outline can be used as a guide to positioning Objects for several common screen 
resolutions. This guide can be toggled on/off with the Options Guide command or “Ctrl B”
shortcut.

Arrange Bar:
The Arrange Bar provides numerous tools for positioning, aligning and ordering an Object



in the Work Window. For more details see the Arrange menu



Publish your HTML project (How To)

Exporting your project will produce a number of files that need to be copied to your server to
display your finished HTML web pages. This process is called Publishing. IMS Web Engine 
provides basic FTP support that is suitable for transferring files directly to your host server or
web site. You can also export your project to a directory on your computer. This is useful if 
you have more complex FTP requirements and wish to use a specialized transfer program or 
if you simply wish to maintain a local copy of your exported projects. If you are unfamiliar 
with FTP (File Transfer Protocol) or the process of transferring files to your web site, you 
should contact the technical support department of your ISP hosting service to determine 
what login procedures and requirements they have.
 
Use the Export_HTML Dialog in the File menu or Toolbar to create multiple export profiles. 
Export Profiles can be created to identify a Web Site or local directory, to set FTP options, to 
identify the export pages, to gather all referenced files together and to select HTML options.
 
Test your Project:

Prior to exporting, you should test your project with the appropriate Preview menu 
buttons.

Which Browser Version?
IMS Web Engine output supports both version 3.2 and version 4 and above HTML 
browsers. Version 3.2 Browsers do not support Dynamic HTML. If your project does not 
include Actions or Behaviors, then publishing for this Browser    version will produce fewer
and smaller files.

Output for version 4 DHTML Browsers should be selected when Actions and Motions are 
used. Output for DHTML Browsers will still work correctly in a 3.2 browser but without the
advanced features. A 3.2 browser will display 4.0 output similar to the IMS Work Window.

What Files are created and used?
IMS Web Engine will produce a HTML file “PageName.htm” for each page in your project. 
If you are exporting for Dynamic HTML the program will also produce a Javascript file 
called “PageName.js”. The actual “PageName” will default to the first page name of your 
project but can be changed in the Export dialog. 

A common Javascript file called “vmmech.js” is also used by DHTML projects. 
“vmmech.js” is included in the projects’ ..\bin directory. When you Export a DHTML 
project with the Relative file path option, the HTML file will expect to find “vmmech.js” in 
the “/bin” subdirectory on the server. You can locate “vmmech.js” in a different directory 
on your server with the HTML Target dialog. Whichever directory is targeted on the locale
machine must exist with a copy of “vmmech.js” on the server

Where are my Files?
When you export your project, IMS Web Engine will copy the page HTML files and the 
project Javascript file to the directory you select in the export dialog. Your project HTML 
files may also reference numerous bitmap and audio files (.gif, .jpg etc.) and will also 
reference “vmmech.js” if you selected Dynamic HTML. The location of these files 
depends upon the “Path Options” you selected. IMS Web Engine supports both Relative 
and Absolute paths to files and provides a “Gather” function to collect all referenced files.

The “Gather” option is the safest and simplest method. All referenced files will be copied 
to the Export directory. If you export your project to an empty directory, then you can 
copy every file in the directory to your server to safely publish your project.



Using the “Relative” option is appropriate when large web sites are being created with 
multiple sub-directories. If your authoring computer mirrors the directory structure on 
your server, you can then reference resource files across directories. This option has not 
been designed to work across multiple hard drives.

The “Absolute” option will reference resource files with the full directory and hard drive 
paths. This option will consequently only work if the Authoring computer and Server have
identical hard drive names and directory structures.

Can I Modify the HTML files?
IMS Web Engine produces a HTML file for each page in your project. The name of the file 
is typically the same as the name of each project page with the “.htm” extension. These 
are typical HTML files and can be modified as needed provided the integrity of the 
Dynamic HTML structure is not compromised. Some third party HTML editors may modify
the HTML code and produce incorrect results. Check with your software vendor to 
confirm that their product does not alter imported HTML. 

Can I Add my own Javascript?
Dynamic HTML files produced by IMS Web Engine include a Script near the end of the 
file. This script is executed after the HTML file has loaded and calls a function that 
executes once per frame. This is the main loop for executing animation and events. 
Knowledgeable Javascript programmers can include a call to their own functions if they 
wish. To include a call that executes once after the HTML file has loaded, place the call in 
the “OnLoad” script prior to the “frameloop” call. To execute a function once per frame, 
include the call in “function frameloop”.

The Javascript files produced by IMS Web Engine and “vmmech,js” should not be 
modified.



How To Use Templates (How To)

IMS Web Engine includes several template “.ims” files in the \Templates sub-directory from 
where the program was installed. These files can be used as guides to help you understand 
how an IMS project is constructed. They can also be used as templates in the creation of 
your own project.

To modify the text in a template file, double click text that you wish to alter. This will display 
the Text_Editor dialog. Simply replace the text in the dialog with your new text.

To modify an image in a template file, single click the image with your mouse and select the 
Geometry_Editor dialog. The first page of this dialog will display an edit box with the file path
to the image. Press the edit box drop down button and use the file open dialog to select a 
new image.

You can move and scale your new text or image Objects as needed with your mouse.

Additional template files will be posted from time to time at the Virtual Mechanics web site: 
http://www.VirtualMechanics.com.



Tutorials (Help)

This command will display a HTML page with several On Line tutorials. These tutorials are 
designed to provide additional insight into the use of IMS Web Engine. A link to the Virtual 
Mechanics web site is also available were updated tutorials and FAQ’s will be posted from 
time to time.



Object Editor Dialog

The Object Editor provides the following dialog pages:

Components Select the current Object.
Position Set Object position.
Rotate Set Object rotation.
Scale Set Object scale.
Links Set Object URL Links
Options Set Object options.



Components Dialog (Object Editor)

The Object Editor Components Dialog is used to select an Object, change its name, change 
its components and delete used or unwanted Objects. 

Selecting “****” in a component drop down box will disable the specified component. Refer 
to the section Understanding Objects for more information on the use of Objects.

Object Name: 
Displays the name of the current Object being edited. Use the drop down box to edit 
another Object component. 

You can change the name of the current Object by typing a new name into the edit box. 
Object names must contain ten or fewer characters, must not start with an alphanumeric
character and must not contain any blank or special characters. By default, names will 
be assigned as: Obj1, Obj2. Obj3 etc. You can change these names to be more 
descriptive in each edit box.

Delete: 
Deletes the Object from all pages in the Project. This operation checks if the Objects 
components are used by any other Objects or components and deletes those that would 
otherwise be orphaned.

Clean: 
This operation checks that all Objects are Included in at least one Page and offers to 
Delete those that are not. The Clean operation follows the same rules as the Delete 
command. 

Geometry: 
Displays the Geometry component associated with this Object. Use the drop down box to
select a different Geometry. An Object’s Geometry can also be dynamically changed with
either the Metamorph operation of a Behavior or the Orientation component of an Action.

Geometry Type: 
Displays the current Geometry type. This can not be changed. Valid types include: 
Rectangle, Ellipse, Shape, Sprite and Text.

Shading: 
Displays the Shading component associated with this Object. Use the drop down box to 
select a different Shading component. Shading can be defined with the Shading Dialog.     

Sound: 
This component is reserved for future updates of IMS Web Engine.

Action: 
Displays the Action component associated with this Object. Use the drop down box to 
select a different Action component. Action can be defined with the Action dialog. 

Behavior: 
Displays the Behavior component associated with this Object. Use the drop down box to 
select a different Behavior component. Behavior can be defined with the Behavior dialog.



Position Dialog (Object Editor)

Sets the position of the Object in the Work Window. See the section on Working in the IMS 
Window.for more details on transforming Objects.

Horizontal: 
Sets the Object’s position horizontally. Enter a precise value into the edit box or use the 
adjacent value adjust arrows. 

Vertical: 
Sets the Object’s position vertically. Enter a precise value into the edit box or use the 
adjacent value adjust arrows. 

Relative Position: 
Will set the new Vertical and Horizontal coordinates relative to the Object’s current 
position. 

Absolute Position: 
Will set the new Vertical and Horizontal position using absolute window coordinates.



Rotate Dialog (Object Editor)

Sets the rotation of the Object in the Work Window. This operation is only available for vector
geometry. See the section on Working in the IMS Window.for more details on transforming 
Objects.

Degrees: 
Sets the Object’s rotation. Enter a precise value into the edit box or use the adjacent 
value adjust arrows. 

90: 
Sets the Object rotation to 90 degrees. 

180: 
Sets the Object rotation to 180 degrees. 

270: 
Sets the Object rotation to 270 degrees. 

0/360: 
Sets the default rotation to zero degrees.
 



Scale Dialog (Object Editor)

Stretches an Object on the X and Y axes as a percentage of its original size. See the section 
on Working in the IMS Window.for more details on transforming Objects.

Horizontal: 
Stretches the Object on the X axis. Enter an integer value into the edit box or use the 
scroll buttons to adjust the value. A value of 100% will set the Object’s normal width. 

Vertical: 
Stretches the Object on the Y axis. Enter an integer value into the edit box or use the 
scroll buttons to adjust the value. A value of 100% will set the Object’s normal height. 

Mirror: 
Will set a horizontal scaling value of -100%. 

Flip: 
Will set a vertical scaling value of -100%. 

Maintain aspect ratio: 
When checked, adjusting either the Vertical or Horizontal scaling value will adjust the 
value on the other axis by an equivalent amount. 



Link Dialog (Object Editor)

Set a URL Link that activates when the Object is selected with the left mouse button. This 
will include the Anchor tag <A HREF=”url”> with the Object’s HTML definition.    More 
complex link decisions can be made with the Link Tab. in a Behavior Definition.. See 
Understanding Objects.for more details on Objects.

Anchor URL: 
Enter the URL of the page to link too. You can create an e-mail link by entering “mailto:” 
followed by the e-mail address. You must also check the ‘Link to URL’ check box for the 
anchor to be included in the HTML document. 

Page List: 
Will include the URL of a page in the current project. You must also check the ‘Link to 
Page’ check box for the anchor to be included in the HTML document.

Anchor Title: 
Will include a title for the URL that is displayed when the mouse moves over the link. The
‘Include Title’ check box must be checked in order for the title to be included in the 
anchor.



Options Dialog (Object Editor)

Set various flags and options associated with the Object. See the section on Understanding 
Objects.for more details on Objects.

Set Visible when loading: 
By default, when defined in a HTML file, an Object will be assigned a Style of visible. Un-
checking this flag will assign a Style of “Hidden”, causing the Object to be invisible when 
the HTML file is first loaded.. 

Set Visible when playing: 
By default, after the HTML file is loaded, an Object will be made visible. Un-checking this 
flag will assign a Style of “Hidden”, causing the Object to be invisible when the HTML file 
has finished loading. If an Object has a Behavior component, the Object’s Active and Not 
Active Visibility setting will override this setting. See the Behavior Actions dialog for more
details.

Set Visible on Mouse Over: 
By default, when defined in a HTML file, an Object will be assigned a Style of visible. Un-
checking this flag will cause the Object to disappear when the mouse moves over it. Use 
this and the ‘Set Visible on Mouse Leave’ check boxes to create Mouse Over effects.

Set Visible on Mouse Leave: 
Un-checking this flag will cause the Object to disappear when the mouse cursor is not 
over it. Use this and the ‘Set Visible on Mouse Over’ check boxes to create Mouse Over 
effects.

Set Initial Active: 
By default, when an Object contains a Behavior component it will be loaded with its 
Behavior in the ‘Not Active’ state. Checking this flag will cause the Object’s Behavior to 
be set to the ‘Active’ state when first loaded. See the Behavior Actions dialog for more 
details.

Reset Transforms: 
Use this button to return an Object’s transformation matrix to its default settings.This is 
equivalent to moving the Object to 0,0 on the X,Y axes with a rotation of zero and scaling
factors of 100%, 100% vertically and horizontally.



Wizard Dialog

The HTML Publisher provides the following dialog pages:

Mouse 
OverWizard_Mouseo
ver

Mouse Over Effect

Strobe 
EffectWizard_Strobe

Strobe Object Effect



Mouse Over Wizard (Wizard Dialog)

A Mouse Over Effect will display or change an Object as the user moves the mouse over it 
and will optionally include a hyper-link.

The Mouse Over Wizard assists in the creation of a Mouse Over effect by guiding the user 
through the selection of the Mouse Out Object, the Mouse Over Object and the Hyper-Link. 
The Wizard will also combine the Objects into a Temporary Group and move them together 
so that the Effect can be easily positioned on the page. 



Strobe Object Wizard (Wizard Dialog)

A Strobe Object Effect will flash one Object or alternate two Object On/Off and will optionally 
include a hyper-link.

The Strobe Object Wizard assists in the creation of a Strobe effect by guiding the user 
through the selection of the Strobe On Object, the Strobe Off Object and the Hyper-Link. The 
Wizard will also combine the Objects into a Temporary Group and move them together so 
that the Effect can be easily positioned on the page. 



Select Object (Wizard Dialogs)

The Select Object Dialog is used in several Wizards to select an Object.

Selected Object
This box will display the currently selected Object image and name. The drop down 
Combo Box can be used to select or change the selected Object.

Load Image
This button will display the Load_Imagedialog so that a new Image can be created.

Load Text
This button will display the Create Text dialog so that a new Text Object can be created.

Do not display
Some Wizards provide the option of not select an Object. This check box    will be 
displayed when this option is available. 



Set Options (Mouse Over Wizard)

This dialog is used to set several options in the Mouse Over Wizard

Group Objects
When checked, this option will position the Mouse Over and Mouse Out Objects together 
and create a Temporary Group. A Temporary Group can be used to position the two 
Objects together on the page. A Temporary Group is destroyed as soon as the page is 
Previewed or another Object is selected.

Link to Page
Check this button and select a Page from the drop down box if you wish to create a 
Hyper Link to another page in your current project.

Link to URL
Check this button and enter a valid URL into the edit box if you wish to create a Hyper 
Link to another page or web site. 



Set Options (Strobe Object Wizard)

This dialog is used to set several options in the Strobe Object Wizard

Group Objects
When checked, this option will position the Strobe On and Strobe Off Objects together 
and create a Temporary Group. A Temporary Group can be used to position the two 
Objects together on the page. A Temporary Group is destroyed as soon as the page is 
Previewed or another Object is selected.

Link to Page
Check this button and select a Page from the drop down box if you wish to create a 
Hyper Link to another page in your current project.

Link to URL
Check this button and enter a valid URL into the edit box if you wish to create a Hyper 
Link to another page or web site. 

Flash Rate
This slider is used to adjust the Flash Rate from slow to fast. The Slowest Rate set by the 
slider is approximately 10 seconds. Slower rates can be set by adjusting the Behavior 
attached to the Flash On Object. 



Object menu and Toolbars commands

The Object menu provides the following commands:

Object Bar:

Editor Displays the Object Editor dialog.
Object Name Displays the name of the current Object.
Geometry Name Displays the name of the current Geometry.
Shading Name Displays the name of the current Shading.
Sound Name Displays the name of the current Sound.
Action Name Displays the name of the current Action.
Behavior Name Displays the name of the current Behavior.

Components Bar:

Wizard Displays the Wizard dialog.
Lock Lock or Release the Object Transformation Matrix.
Select Enter Select Mode. Use the mouse to select an Object
Select Enter Vertex Mode. Use the mouse to move the points on a selected 

Polygon Object
Rectangle Creates a new Object with a Rectangle Geometry.
Ellipse Creates a new Object with an Ellipse Geometry.
Shape Creates a new Object with a Polygon Geometry and places IMS 

Studio into Vertex enter mode.
Image Creates a new Object and displays the Sprite Dialog to select a 

bitmap geometry.
Title Creates a new Object and displays the Text Dialog to define Plain 

Text 
geometry.

Text Creates a new Object and displays the Text Dialog to define Rich Text
geometry.

Word Creates a new Object and attempts to open the default system word 
processor.

HTML Creates a new Object and displays the Text Dialog to define HTML 
geometry.

Geometry Displays the Geometry dialog.
Shading Displays the Shading dialog.
Sound Displays the Sound dialog.
Action Displays the Action dialog.
Behavior Displays the Behavior dialog.

See the section Understanding Objects for more details on creating and using IMS Web 
Engine Objects.



Object Editor command (Object menu)

This command will display the Object_Editor. The Object Editor provides dialogs to select or 
change Object components, to set precise transformations and to select browser options.

To learn more about Objects see the section on Understanding Objects.. To learn more about 
using the IMS work window see the section on Working in the IMS Window.. To learn more 
about motion paths see the section on Understanding Animation.. 

Shortcuts 

Object Bar:



Object Name List Box (Object menu)

This Edit box displays the name of the currently selected Object or “*****” if no Object is 
currently selected. You can change the name of the current Object by typing a new name 
into the edit box. Object names must contain ten or fewer characters, must not start with an
alphanumeric character and must not contain any special characters.

The drop down box lists all Objects in the project. Any Object can be selected from this list 
even if the Object is not contained in the current Page. If the selected Object is contained in 
the current page it will be highlighted. If it is not a member of the current page it will be 
selected but not highlighted.

To Include or copy an Object to the current page when it is not a member of the current 
page, select it with the Object Name Edit Box and use the Copy/Paste commands.

To view and select only those Objects that are already included in the current page use the 
Page Object List.



Geometry Name Edit Box (Object menu)

This Edit box displays the name of the Geometry component of the selected Object or 
“*****” if the selected Object does not include a Geometry component. You can change the 
name of the current geometry by typing a new name into the edit box. Geometry names 
must contain ten or fewer characters, must not start with an alphanumeric character and 
must not contain any special characters.

Use the Object Editor    dialog to change an Objects Geometry component.



Shading Name Edit Box (Object menu)

This Edit box displays the name of the Shading component of the selected Object or “*****” 
if the selected Object does not include a Shading component. You can change the name of 
the current shading by typing a new name into the edit box. Shading names must contain 
ten or fewer characters, must not start with an alphanumeric character and must not 
contain any special characters.

Use the Object Editor    dialog to change an Objects Shading component.



Sound Name Edit Box (Object menu)

This Edit box displays the name of the Sound component of the selected Object or “*****” if 
the selected Object does not include a Sound component. You can change the name of the 
current sound by typing a new name into the edit box. Sound names must contain ten or 
fewer characters, must not start with an alphanumeric character and must not contain any 
special characters.

Use the Object Editor    dialog to change an Objects Sound component.



Action Name Edit Box (Object menu)

This Edit box displays the name of the Action component of the selected Object or “*****” if 
the selected Object does not include a Action component. You can change the name of the 
current Action by typing a new name into the edit box. Action names must contain ten or 
fewer characters, must not start with an alphanumeric character and must not contain any 
special characters.

Use the Object Editor    dialog to change an Objects Action component.



Behavior Name Edit Box (Object menu)

This Edit box displays the name of the Behavior component of the selected Object or “*****” 
if the selected Object does not include a Behavior component. You can change the name of 
the current Behavior by typing a new name into the edit box. Behavior names must contain 
ten or fewer characters, must not start with an alphanumeric character and must not 
contain any special characters.

Use the Object Editor    dialog to change an Objects Behavior component.



Object Lock/Unlock command (Object menu)

This command will lock or unlock an Objects transformation Matrix. When locked, 
transformation operations can not be performed on an Object. If an Object is already locked, 
this command will unlock it.. A colored lock will appear on the Object toolbar when a locked 
Object is selected. A key will appear when an unlocked Object is selected.

 Locking an Object is useful when you wish to prevent accidental editing of an Object.

To learn more about Objects see the section on Understanding Objects.. To learn more about 
using the IMS work window see the section on Working in the IMS Window.. To learn more 
about motion paths see the section on Understanding Animation.. 

Shortcuts 
Object Bar:  



Wizard command (Object menu)

This command will display the Mouse Over WizardEditor Dialog. This Wizard is used to easily 
create Mouse Over Effects. Future releases will include additional Wizard for the creation of 
special effects.

Shortcuts

Components Bar:



Rectangle command (Object menu)

This command will create a new Object with a Rectangle Geometry at the center of the IMS 
Studio work window. Use your mouse or the Object Editor to scale, stretch and position the 
rectangle to its desired location.

Rectangle geometry can be used as a motion path. Rectangle geometry will not be visible 
when displayed in the browser unless Shading or a Geometry line width is also attached to 
the Object.

To learn more about Objects see the section on Understanding Objects.. To learn more about 
using the IMS work window see the section on Working in the IMS Window.. To learn more 
about motion paths see the section on Understanding Animation.. 

Shortcuts

Components Bar:



Ellipse command (Object menu)

This command will create a new Object with an Ellipse Geometry at the center of the IMS 
Studio work window. Use your mouse or the Object Editor to scale, stretch and position the 
ellipse to its desired location and shape.

Ellipse geometry can be used as a motion path. Ellipse geometry will not be visible when 
displayed in the browser unless Shading or a Geometry line width is also attached to the 
Object.

To learn more about Objects see the section on Understanding Objects.. To learn more about 
using the IMS work window see the section on Working in the IMS Window.. To learn more 
about motion paths see the section on Understanding Animation.. 

Shortcuts

Components Bar:



Shape command (Object menu)

This command will create a new Object with Polygon Shape Geometry. Upon selecting this 
command, IMS Studio will be in Vertex Enter Mode. Each time you press the left mouse 
button, a new vertex will be appended to the polygon. A vector will rubber band from the 
last point to the mouse and from the mouse to the first point on the polygon. Holding the left
mouse button down while moving the mouse will enter sketch mode and drop vertices at 
periodic intervals. The sketch mode interval can be adjusted with the Freehand Resolution 
Slider in the Tools Options Dialog.

To create a Closed polygon select the first point on the polygon. To create an Open polygon 
double click the last point.

Shape geometry can be used as a motion path. Shape geometry will not be visible when 
displayed in the browser unless Shading or a Geometry line width is also attached to the 
Object.

To learn more about Objects see the section on Understanding Objects.. To learn more about 
using the IMS work window see the section on Working in the IMS Window.. To learn more 
about motion paths see the section on Understanding Animation.. 

Shortcuts

Components Bar:



Sprite command (Object menu)

This command will create a new Object and display the Sprite Dialog to select Bitmap 
Geometry.

Sprite geometry can be used as a rectangular motion path.

To learn more about Objects see the section on Understanding Objects.. To learn more about 
using the IMS work window see the section on Working in the IMS Window.. To learn more 
about motion paths see the section on Understanding Animation.. 

Shortcuts

Components Bar:



Title command (Object menu)

This command will create a new Object and display the Text_Editor dialog to create or load 
Plain Text Geometry. Plain Text has a single color, font face, size etc. and can be scaled to 
any size on the Y axis.

Text geometry can be used as a rectangular motion path. Text can be assigned a background
color by including a shading component with the Object. 

To learn more about Objects see the section on Understanding Objects.. To learn more about 
Text see the section on Understanding Text.. To learn more about using the IMS work window 
see the section on Working in the IMS Window.. To learn more about motion paths see the 
section on Understanding Animation.. 

Shortcuts

Components Bar:



Text command (Object menu)

This command will create a new Object and display the Text_Editor dialog to create or load 
Rich Text Geometry. Rich Text can display text with multiple font faces, colors, sizes etc. 
Scaling a Rich Text Object on the Y axis will not affect the text size. Rich Text is a common 
format for most Word Processors.

Text geometry can be used as a rectangular motion path. Text can be assigned a background
color by including a shading component with the Object. 

To learn more about Objects see the section on Understanding Objects.. To learn more about 
Text see the section on Understanding Text.. To learn more about using the IMS work window 
see the section on Working in the IMS Window.. To learn more about motion paths see the 
section on Understanding Animation.. 

Shortcuts

Components Bar:



Word Processor command (Object menu)

This command will create a new Object and attempt to display the system Word Processor 
that is attached to “.rtf” files. To transfer text from the Word Processor, select it with your 
mouse and ‘Copy’ it. (It will be stored in the system clipboard). Close the Word processor or 
open the IMS Text_Editor with the IMS button that will displayed on the system task bar. 
Select the Text Window and ‘Paste” the stored text into it from the Clip Board. You can also 
use Ctrl-C and Ctrl-V to cut and paste. Alternatevely, you can Save the Word Processor into a
“.rtf” file and then load it into the IMS Text Editor with the “Open” command.

The default file type can be changed from “.rtf” in the Tool Options dialog. 

Text geometry can be used as a rectangular motion path. Text can be assigned a background
color by including a shading component with the Object. 

To learn more about Objects see the section on Understanding Objects.. To learn more about 
Text see the section on Understanding Text.. To learn more about using the IMS work window 
see the section on Working in the IMS Window.. To learn more about motion paths see the 
section on Understanding Animation.. 

Shortcuts

Components Bar:



HTML command (Object menu)

This command will create a new Object and display the Text_Editor dialog to create or load 
HTML text Geometry. A HTML object is not interpreted but is copied to the Export HTML file 
‘As Is’. HTML Objects are consequently ideal for entering HTML tags, scripts or other code 
that must not be modified.

Text geometry can be used as a rectangular motion path. Text can be assigned a background
color by including a shading component with the Object. 

To learn more about Objects see the section on Understanding Objects.. To learn more about 
Text see the section on Understanding Text.. To learn more about using the IMS work window 
see the section on Working in the IMS Window.. To learn more about motion paths see the 
section on Understanding Animation.. 

Shortcuts

Components Bar:



Geometry command (Object menu)

This command will display the Geometry_Editor. The Geometry Editor provides dialogs to 
select or change Geometry, to set a Geometry’s outline and to change a Geometry origin.

To learn more about Objects see the section on Understanding Objects.. To learn more about 
using the IMS work window see the section on Working in the IMS Window.. To learn more 
about motion paths see the section on Understanding Animation.. 

Shortcuts

Components Bar:



Shading command (Object menu)

This command will display the Shading_EditorThe Shading Editor provides dialogs to select 
or change shading associated with an Object’s geometry component. Shading is used to 
define a background fill color for text, sprite, and vector based Objects. Vector Objects can 
also be assigned a texture map.

To learn more about Objects see the section on Understanding Objects.. To learn more about 
using the IMS work window see the section on Working in the IMS Window.. To learn more 
about motion paths see the section on Understanding Animation.. 

Shortcuts

Components Bar:



Sound command (Object menu)

This command will display the Sound Editor The Sound Editor provides dialogs to select or 
change sound effects associated with an Object. By default, a sound effect will play 
emmediately upon loading unless you use a Behavior to control it.

Note: Sound effects are currently only available in Internet Explorer 4.0 and later. Use the 
Page Music command to play cross browser background music.

To learn more about Objects see the section on Understanding Objects.. 

Shortcuts

Components Bar:



Action command (Object menu)

This command will display the Action Editor. The Action Editor provides dialogs to select or 
change motions associated with one or more Objects.

To learn more about Objects see the section on Understanding Objects.. To learn more about 
using the IMS work window see the section on Working in the IMS Window.. To learn more 
about motion paths see the section on Understanding Animation.. 

Shortcuts

Components Bar:



Behavior command (Object menu)

This command will display the Behavior_Editor. The Behavior Editor provides dialogs to 
define complex behaviors and events associated with one or more Objects.

To learn more about Objects see the section on Understanding Objects.. To learn more about 
using the IMS work window see the section on Working in the IMS Window.. To learn more 
about motion paths see the section on Understanding Animation.. 

Shortcuts

Components Bar:



Select (Components toolbar)

This Tools button is used to return the program to select object mode after being placed into 
Zoom or Edit Vertex mode.

Shortcuts

Components Bar:



Edit Vertex (Components toolbar)

This Tools button is used to place the program into Edit Vertex mode. The current selected 
Object will be displayed with a select box at each vertex in the Geometry. The mouse can be 
used to drag the vertex box to a new valid position.

Currently only Shape geometry can be edited with this operation to change the polygons 
vertex location. Future IMS Web Engine versions will provide Rectangle and Ellipse vertex 
editing support.

After completing the vertex editing operation, you should return to Select mode for normal 
operation.

Shortcuts

Components Bar:




